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ВВЕДЕНИЕ 
 
В данном разделе рассматриваются вопросы, связанные с разра-

боткой конструкторских приложений на базе универсальной системы 
геометрического моделирования. Конструкторское проектирование – 
процесс творческий, трудно формализуемый. Поэтому основные 
средства его автоматизации – системы геометрического моделирова-
ния – КОМПАС 3D, SolidWorks, NX и т. п. Они позволяют быстро 
визуализировать решение в виде объемной модели, подготовить кон-
структорскую документацию, выполнить инженерный анализ и др. 
Наряду с творческими задачами конструктору приходится выполнять 
много рутинных процедур, связанных с описанием типовых реше-
ний. Соответствующие программные средства были бы важным под-
спорьем в его работе. В пользу подобных средств говорит и имеющая 
место тенденция к разработке проблемно ориентированных модулей 
на базе универсальных систем: «Mold Wizard» (проектирование 
пресс-форм) и «Progressive Die Wizard» (штампы последовательного 
действия) в системе NX, «РЕДУКТОР-3D V2.3» (одноступенчатые 
редукторы) в системе КОМПАС 3D и др. 

В качестве объекта проектирования предлагается приспособле-
ние для установки и закрепления деталей при выполнении над ними 
различных технологических операций. В первой работе на данном 
примере предлагается ознакомиться с основными принципами авто-
матизированного конструирования. Вторая работа посвящена озна-
комлению с программным интерфейсом системы геометрического 
моделирования на примере вставки конструктивного элемента в сбо-
рочную модель. В третьей работе рассматриваются способы решения 
задач позиционирования при помощи сопряжений. Четвертая работа – 
ознакомление с внутренней структурой твердотельной геометриче-
ской модели и способами извлечения информации из нее. 
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1. ПРОЕКТИРОВАНИЕ ПРИСПОСОБЛЕНИЯ  
ДЛЯ УСТАНОВКИ И ЗАКРЕПЛЕНИЯ ДЕТАЛЕЙ 

 
1.1. Цели и задачи 

 
В «конструирующие» программы1 при разработке закладывают-

ся определенные технологии конструирования, в основе которых 
лежат традиционные методики проектирования, используемые кон-
структорами. С другой стороны, неотъемлемой составляющей со-
временного конструирования являются системы геометрического 
моделирования – «SolidWorks», КОМПАС 3D и т. п. Сочетание 
возможностей этих систем с традиционными методиками конструи-
рования обеспечивает эффективную программную поддержку конст-
руирования соответствующего класса объектов. Отработать логику 
программ позволяет интерактивное проектирование в геометриче-
ской системе, соблюдая соответствующие методики способствует. 
Цель работы: ознакомиться с основными принципами конструи-

рования технических объектов с использованием средств автомати-
зации проектирования. Для достижения поставленной цели предла-
гается решить задачу проектирования объекта заданного класса, 
используя соответствующие методические указания и систему гео-
метрического моделирования. 

 
1.2. Объект проектирования 

 
В качестве объекта проектирования предлагаются приспособле-

ния для установки и закрепления деталей при выполнении над ними 
различных технологических операций – механической обработки, 
сборки и т. п. 

Деталь, которая устанавливается и закрепляется, называется объ-
ектом оснащения. Пусть в качестве такового объекта задана деталь Д 
(рис. 1.1). В ней необходимо прорезать уступ шириной B и глубиной h. 
Уступ можно вырезать инструментом И (рис. 1.2), инструмент надо 
закрепить в станке (рис. 1.3, а). Деталь надо также закрепить на стан-
ке. Причем сделать это надо так, чтобы пересечение инструмента  
и детали имело размеры паза. Для этого на столе станка крепится 

                                                      
1 Программы, поддерживающие генерирование конструкторских решений. 
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опора О так, чтобы ее верхняя грань находилась на расстоянии H-h 
от нижнего торца инструмента (рис. 1.3, б). Там же на столе уста-
навливается упор У на расстоянии В от внешнего края инструмента. 
Любая деталь, аналогичная детали Д, устанавливается поверхностью 
Б1 на опору О и упирается поверхностью Б2 в упор У. Инструмент И 
при этом вырежет в детали именно такой паз, который нужен. 

 

 
 
 

 

Рис. 1.1. Деталь, размерная схема 
 

Рис. 1.2. Инструмент 
 

 
а б 

 

Рис. 1.3. Размещение детали относительно инструмента (а) и приспособление (б) 
 

В приведенном примере приспособление – это опора О и упор У. 
В действительности опора О и упор У – только части приспособле-
ния, так называемые установочные элементы. Кроме них необходи-
мы, например, закрепляющие элементы. 
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Установочные и закрепляющие элементы непосредственно реа-
лизуют функцию приспособления, поэтому они называются функ-
циональными. 

Функциональные элементы объединяются корпусом. На рисунке 
он не показан, но он обязательно должен быть. На нем собираются 
все детали приспособления, и оно устанавливается на оборудование 
именно при помощи корпуса. 

Таким образом, структура приспособления включает элементы 
установочные, закрепляющие и корпус (рис. 1.4). Это минимальная 
структура. Кроме того, в приспособлении могут быть различные 
вспомогательные элементы. 

Поверхности детали, которыми она устанавливается в приспо-
собление, называются «базы». В приведенном примере (рис. 1.1) 
базами являются поверхность Б1, которой деталь ложится на опору, 
и поверхность Б2, которой деталь упирается в упор. 

Поверхности установочных элементов (см. рис. 1.1), на которые 
устанавливается (УП1) деталь и в которые она упирается (УП2) 
называются «установочные поверхности приспособления». 

На рис. 1.4 приведен пример приспособления рассмотренного 
случая. 
 

 
 

Рис. 1.4. Внешний вид приспособления для прорезания паза 
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1.3. Методика проектирования приспособления 
 

Проектирование приспособлений, в общем случае, задача слож-
ная и творческая. Они достаточно разнообразны, что обусловлено 
разновидностью деталей – объектов оснащения. Тем не менее, струк-
тура этих объектов подчиняется определенным закономерностям. 
Эти два фактора: разнообразие и наличие закономерностей – делают 
приспособления интересным объектом автоматизации конструктор-
ского проектирования. 

Исходная информация для проектирования приспособления – 
описание детали – объекта оснащения. Документальное его описа-
ние традиционно представляется в виде конструкторского чертежа. 
В данной работе для проектирования используется система геомет-
рического моделирования. Соответственно, описание детали – гео-
метрическая модель в твердотельном формате. 

Приспособление – сборный объект. Соответственно, необходимо 
создать новый документ, поддерживающий формирование сбороч-
ных единиц. В этот документ в качестве первого компонента встав-
ляется модель объекта оснащения (рис. 1.5, а). 

 

а б 
 

Рис. 1.5. Внешний вид (а) и базовые поверхности (б) объекта оснащения  
 
Основная характеристика объекта оснащения – комплект баз. 

Для установки любой детали, в общем случае, необходимо и доста-
точно три базы. В большинстве случаев базы – это плоские или ци-
линдрические поверхности. Выбор баз определяется технологиче-
ским процессом в целом. Поэтому в рамках данной работы базы 
считаются заданными (рис. 1.5, б). 
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1.4. Размещение функциональных элементов 
 

Функциональными считаются установочные и закрепляющие 
элементы. 

Установочные элементы размещаются относительно баз. Эта про-
цедура включает две задачи: выбор элементов и их позиционирование. 

Принцип выбора элементов в рамках данной работы простой. 
Среди установочных элементов можно выделить несколько наибо-
лее распространенных классов: 

 опора – элемент с горизонтальной установочной поверхно-
стью (рис. 1.6, а, б); 

 упор – элемент с вертикальной установочной поверхностью, 
в качестве которого можно использовать цилиндрический палец 
(рис. 1.7, а); 

 палец – элемент с цилиндрической установочной поверх-
ностью (рис. 1.7). 
 

а б в 
 

Рис. 1.6. Опоры установочные:  
а – с плоской головкой; б – пластина опорная; в – опорная призма 

 

а б в 
 

Рис. 1.7. Пальцы установочные:  
а – цилиндрический; б – срезанный; в – выдвижной 
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Для горизонтальных баз выбираются опоры, для вертикальных – 
упоры, для отверстий – пальцы. Если горизонтальная база – цилиндр, 
следует использовать опору призматическую. Если имеется два ба-
зовых отверстия, один из пальцев должен быть срезанным. Если оси 
отверстий не параллельны, один из пальцев (сбоку) должен быть 
выдвижным. 

При расстановке установочных элементов в рамках данной рабо-
ты также можно руководствоваться простейшим принципом устой-
чивости. 

Для этой устойчивости, прежде всего, необходимо обеспечить 
горизонтальную установочную поверхность. Она должна быть до-
статочно развитой, чтобы деталь не качалась. Сплошная поверх-
ность не годится – это не технологично. Следовательно, она долж-
на быть фрагментальной. Как известно из геометрии, плоскость 
определяется тремя точками. Поэтому для плоской горизонтальной 
базы следует выбрать три опоры и расставить их пошире (рис. 1.8, а). 

 

  
а б в г 

 

Рис. 1.8. Схема установки: 
а – опоры и два упора; б, в – отклонения от заданного положения;  

г – окончательный вариант 
 

Далее необходимо ограничить перемещения вдоль горизонталь-
ной установочной поверхности. Для этого против каждой верти-
кальной базы устанавливается упор (см. рис. 1.8, а). Однако относи-
тельно этих упоров деталь может перемещаться (рис. 1.8, б, в). 

Чтобы добиться однозначности положения необходимо для од-
ной базы добавить второй упор (рис. 1.8, г). 

Если два установочных элемента расположены достаточно близ-
ко, можно использовать один комбинированный элемент, напри-
мер упор уголковый (рис. 1.9, а). Таким элементом можно заменить 
пару «опора–упор» с правой стороны (рис. 1.9, б). А вот замена 
оставшейся пары комбинированным упором (рис. 1.9, в) не допу-
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стима – опорная точка слишком смещается от своего положения, 
теряется устойчивость. 

 

 
а б в 

 

Рис. 1.9. Комбинированный элемент: 
а – внешний вид; б – направляющая база; в – опорная и направляющая базы 
 

Фиксирующие элементы располагаются так, чтобы их усилие 
было направлено на установочные элементы (рис. 1.10). 

 

 
 

Рис. 1.10. Размещение фиксирующего элемента 
 

1.5. Проектирование корпуса 
 

Корпус приспособления проектируется после расстановки функ-
циональных элементов. Ограничений на конструкцию этого эле-
мента практически нет. Поэтому он может быть любым, главное, 
чтобы соединял между собой функциональные элементы.  
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В данном контексте необходимо ввести понятия привалочная 
грань и привалочная плоскость. В конструкции каждого элемента 
(детали) есть грань, которой он опирается на корпус (рис. 1.11). Это 
и есть привалочная грань конструктивного элемента. 

 

 
 

Рис. 1.11. Привалочные грани функциональных элементов 
 
Элементов в конструкции много. Соответственно, много и при-

валочных граней. Плоскость, параллельная привалочным граням  
и расположенная ниже всех граней, будет называться привалочной 
плоскостью. В приведенном примере ниже всех располагается при-
валочная грань зажима (рис. 1.12, а). С ней и будет связана прива-
лочная плоскость. 

Простейший вариант корпуса – прямоугольная плита. Верхняя 
грань плиты совпадает с привалочной плоскостью (см. рис. 1.12, а). 
Габариты и расположение плиты «в плане» таковы, чтобы ее внеш-
ний контур охватывал проекции всех привалочных граней на при-
валочную плоскость (рис. 1.12, б). 

Промежутки между привалочными гранями функциональных 
элементов и корпусной плитой должны быть заполнены. Для этого 
надо либо удлинить элемент, либо вставить между ним и корпусной 
плитой переходник. 
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а 
 

б 
 

Рис. 1.12. Корпусная плита 
 

1.6. Задания и средства выполнения 
 

Проектирование приспособления выполняется при помощи средств 
геометрического моделирования. Можно выбрать любую систему, 
поддерживающую твердотельное моделирование. Рекомендуемый 
пакет SolidWorks. В последующих работах планируется разработка 
программных средств поддержки проектирования. Соответствен-
но, необходима графическая система, предоставляющая эффектив-
ный интерфейс разработки пользовательских приложений. Solid-
Works – один из лучших представителей таких систем. 

Ознакомиться с набором команд, минимально необходимым для 
компоновки модели приспособления, поможет учебное пособие: 
«Учебные пособия SolidWorks» > «Введение» > «Упражнение 2 – 
Сборки».  

Для создания моделей отдельных деталей (например, при разра-
ботке собственных элементов) полезным будет пособие: «Учебные 
пособия SolidWorks» > «Введение» > «Упражнение 1 – Детали». 
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Исходные данные для выполнения лабораторной работы – гео-
метрическая модель детали в формате STEP (STandard for Exchange 
of Product model data) с выделенными базовыми поверхностями  
(рис. 1.13). Перед началом работы каждую такую модель необхо-
димо импортировать в SolidWorks и сохранить. 

 

 

Рис. 1.13. Геометрическая модель детали с выделенными базами 
 

Элементы приспособления также предоставляются в готовом ви-
де. Однако можно создавать и собственные. Все элементы, исполь-
зуемые при выполнении работы, должны быть скопированы в соб-
ственный раздел. Не следует использовать ссылки на модели из 
указанного «общего» каталога. 

 
2. ИНТЕРФЕЙС ПРОГРАММИРОВАНИЯ ПРИЛОЖЕНИЙ 

ПАКЕТА ГЕОМЕТРИЧЕСКОГО МОДЕЛИРОВАНИЯ 
 

Цель работы: ознакомиться с основными средствами разработки 
пользовательских приложений для систем геометрического модели-
рования. Для достижения поставленной цели предлагается разрабо-
тать процедуры добавления компонента, определенного во внешнем 
файле, в текущий документ. 

Приложение, обеспечивающее программную поддержку конст-
рукторского проектирования некоторого класса технических объек-
тов в среде системы геометрического моделирования, может быть 
организовано как некая макрокоманда, включающая обращения  
к штатным процедурам и функциям пакета и являющаяся своего 
рода имитатором действий проектировщика. Реализовать такое при-
ложение позволяет так называемый интерфейс программирования 
приложений (Application Programming Interface, API). Доскональ-
но его изучить можно при помощи соответствующей документации 
(справочник API). Повысить эффективность как изучения, так и не-
посредственно написания приложений позволяет макрорекордер – 
средство автоматической записи действий в формате какого-либо 
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языка программирования. API и макрорекордер – основные сред-
ства разработки приложений. 

 
2.1. Начало работы 

 

В качестве базовой системы геометрического моделирования 
предлагается SolidWorks. В качестве тестового примера – модель, 
созданная при выполнении работы «Проектирование приспособ-
ления для установки и закрепления деталей». Объект разработки – 
процедура, добавляющая в текущий документ компоненты, опреде-
ленные во внешних файлах. Подобные операции выполняются на 
уровне сборки, поэтому для работы необходимо создать новый до-
кумент типа «сборка» (Asmdoc). 

 
2.2. Макрокоманды 

 

Чтобы выяснить, какие процедуры SolidWorks следует использо-
вать, необходимо изучить справочник API или так называемый 
макрорекордер. 

Команды управления макросами доступны в падающем меню: 
«Инструменты  Макрос». Кроме того можно включить соответ-
ствующую кнопочную панель. 

1. Включить запись макроса. 
2. Добавить в текущий документ какой-либо внешний компонент 

в интерактивном режиме – командой «Вставить компоненты» (па-
нель инструментов «Сборка»). 

3. Выключить запись макроса. 
При выключении записи макроса система автоматически пред-

ложит сохранить его. Вариантов сохранения несколько. По умолча-
нию предлагается формат Visual Basic for Application – SW VBA 
Macros(*.swp). Можно также сохранить макрос как проект Visual 
Studio в Basic-формате – SW VSTA VB Macro(*.vbproj), либо фор-
мате «С#» – SW VSTA C# Macro(*.csproj). 

Далее рассматривается вариант SW VBA Macros(*.swp). 
 

2.3. Анализ и редактирование макроса 
 

Файл, созданный на предыдущем этапе, открывается для редак-
тирования. Сформированный модуль (рис. 2.1) содержит несколько 
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деклараций и процедуру main. Эта процедура и есть тот самый мак-
рос, который был записан при выполнении вставки в интерактив-
ном режиме. 

 

 
 

Рис. 2.1. Автоматически сформированный макрос 
 

swApp – ссылка на приложение SolidWorks. 
Part – ссылка на документ SolidWorks, в данном случае на теку-

щий документ. 
AddComponent – обращение к процедуре добавления детали из 

внешнего файла. Первый аргумент – полное имя файла, последую-
щие три – координаты точки вставки. 

Для проверки работоспособности этого макроса можно изменить 
координаты с последующим его исполнением. Убедиться в том, что 
деталь вставилась в файл сборки. 

 
2.4. Справка по API 

 
Процедуры и функции интерфейса программирования описаны  

в API-справочнике, загрузить который можно из раздела «Справка» 
падающего меню. 

Наиболее эффективным является поиск по ключевым словам 
описания используемых процедур, названия которых можно взять 
из макросов, записываемых в процессе интерактивного выполнения. 

Следует обратить внимание на то, что одноименные методы, как 
принято в объектно-ориентированном программировании, встреча-
ются в разных классах. В частности, процедура AddComponent 
определена и в классе IAssemblyDoc, и в классе IDragOperator. 
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2.5. Процедуры открытия и закрытия файла компонента 
 

Добавление внешнего компонента в системе SolidWorks имеет од-
ну особенность. Для ее демонстрации систему следует полностью 
выгрузить, загрузить снова, создать новый сборочный документ и вы-
полнить ранее созданный макрос. Он не работает. Точнее он работа-
ет, скорее всего, но не так, как раньше – компонент не добавляется. 

Дело в том, что внешнее определение, прежде чем вставлять в те-
кущий документ, необходимо инициализировать в текущем сеансе 
работы. При выполнении команды в интерактивном режиме систе-
ма это делает, но в макрос не записывает. Поэтому его необходимо 
доработать самостоятельно. Простейший способ инициализации – 
открыть соответствующий файл и, соответственно, закрыть после 
добавления. Для этого в макрос следует добавить две строки обра-
щения к методам OpenDoc6 и CloseDoc приложения SolidWorks 
(рис. 2.2). С аргументами этих методов предлагается ознакомиться 
самостоятельно. 

 

 
 

Рис. 2.2. Команды инициализации документа 
 

2.6. Заключение 
 

Методы и средства разработки приложений на базе системы 
геометрического моделирования SolidWorks можно также при по-
мощи учебных пособий: «Учебные пособия SolidWorks» > «Улуч-
шение производительности» > «Интерфейс программирования 
приложений (API) SolidWorks». 
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Как следует из вышесказанного, макросы можно записывать 
также как проекты среды Visual Studio на языке C#, в частности. 
Однако при этом часто возникают сбои. Проще, пожалуй, сразу со-
здать проект в этой среде, организовав доступ к SolidWorks. Фраг-
мент такого проекта приведен ниже. 

 
using System; 
using System.Collections.Generic; 
using System.Linq; 
using System.Text; 
using System.Threading.Tasks; 
using System.Runtime.InteropServices; 
using SolidWorks.Interop.sldworks; 
namespace ConsoleApplication1 
{ 
classProgram 
 { 
staticvoid Main(string[] args) 
 { 
object swApp = Marshal.GetActiveObject("sldworks.application"); 
ISldWorks Swap = swApp asISldWorks; 
object Adoc = Swap.ActiveDoc; 
AssemblyDoc Asm = Adoc asAssemblyDoc; 
string UnitsLibPath = "D:\\BNTU\\OAK\\Units\\"; 
string uName = "Locator1.sldprt"; 
string Addun = UnitsLibPath + uName; 
int Cerr = 0; 
int Cwar = 0; 
 Swap.OpenDoc6(Addun, 1, 0, "", Cerr, Cwar); 
Component2 Comp = Asm.AddComponent5(Addun, 0, "", true, "", 0.1, 
0.1, 0.1); 
 Swap.CloseDoc(Addun); 
 } 
 } 
} 
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3. АВТОМАТИЗАЦИЯ СОПРЯЖЕНИЙ 
 

3.1. Цель и задачи 
 

Одной из важнейших процедур автоматизации конструирования 
является позиционирование элементов конструкций. Можно без-
укоризненно подобрать все детали и узлы, рассчитать их параметры 
и т. д., но если каждый из них придется устанавливать интерактив-
но, ценность всего этого будет сведена на нет. 

Положения элементов описываются координатным способом.  
В пространстве проектирования, где ведется сборка, определяется 
система координат – глобальная (ГСК). С каждым элементом кон-
струкции связана собственная система координат (ССК) – локаль-
ная. В конечном итоге положение компонента описывается матри-
цей 4  4: 

 

11 12 13 1

21 22 23 2

31 32 33 3

,

0 0 0 1

c c c p

c c c p

c c c p

 
 
 
 
 
 

 

 
где ijc  – косинус угла между i-й осью ГСК и j-й осью ССК; 

 ip  – i-я координата точки начала ССК элемента в ГСК.  
Определять все эти координаты и углы сложно. Современные сред-
ства геометрического моделирования поддерживают так называе-
мую ассоциативную сборку – пользователь указывает пары сопря-
гаемых (ассоциируемых) друг с другом граней, а система сама рас-
считывает необходимые параметры расположения. Отмеченную 
возможность можно использовать и программно. Используемые 
при этом методы и средства являются предметом изучения предла-
гаемой работы. 
Цель работы: освоение методов и средств установления сопря-

жений между элементами геометрических моделей сборочных еди-
ниц. 

Для достижения поставленной цели предлагается решить следую-
щие задачи: 



 

23 

 выполнить сборку двух деталей в системе геометрического 
моделирования, используя сопряжения, и записать соответствую-
щий макрос; 

 проанализировать полученный макрос, выделить процедуру, 
непосредственно выполняющую сопряжение, изучить особенности 
ее выполнения, аргументы, способ передачи в нее сопрягаемых 
элементов; 

 разработать процедуру сопряжения компонентов сборки. 
В качестве примера рассматривается вставка в цилиндрическое 

отверстие установочного элемента класса «палец установочный».  
В конечном итоге должна быть разработана процедура, которая 
сделает это автоматически (рис. 3.1). 

 
3.2. Создание макрокоманды 

 
Необходимо создать новый документ типа «сборка» и вставить  

в него деталь с цилиндрическим отверстием и установочный палец. 
 

  

 

Рис. 3.1. Сопряжения установочного пальца с деталью 

Положение пальца относительно детали регламентируется сле-
дующими сопряжениями (см. рис. 3.1): 

– плоская грань буртика (прилегающая к цилиндрической) сов-
падает с торцевой гранью отверстия; 

– цилиндрическая грань пальца соосна с отверстием. 
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Указанные сопряжения устанавливаются в заданном порядке. 
Макрос, записанный при интерактивном установлении указанных 
сопряжений, выглядит примерно следующим образом: 

 
Sub main() 
Set swApp = Application.SldWorks 
Set Part = swApp.ActiveDoc 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1, –0.0, –0.0, 
True, 1, Nothing, 0) 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1, –0.0, 0.0, 
True, 1, Nothing, 0) 
Dim myMate As Object 
Set myMate = Part.AddMate3(0, 1, False, 0.01, 0, 0, 0.01, 0.01, 0, 0.5, 
0.5, False, longstatus) 
Part.ClearSelection2 True 
Part.EditRebuild3 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1, –0.0, –0.0, 
True, 1, Nothing, 0 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1482, –0.0284,  
–0.0073, True, 1, Nothing, 0) 
Set myMate = Part.AddMate3(1, 1, False, 0.01, 0, 0, 0.01, 0.01, 0, 0.5, 
0.5, False, longstatus) 
Part.ClearSelection2 True 
Part.EditRebuild3 
End Sub 
 

3.3. Анализ полученного макроса 
 

Ключевая процедура в данном макросе – AddMate3. Именно она 
непосредственно устанавливает сопряжения. 

Первый аргумент задает тип сопряжения. Это может быть 
«совпадение» сопрягаемых поверхностей, «соосность», «касатель-
ность», «параллельность» и т. п. В записанном макросе первое со-
пряжение – совпадение плоских поверхностей. Соответственно, 
первый аргумент принимает значение «0». Второе сопряжение – 
соосность (концентричность), первый аргумент равен «1». Очевид-
но, что тип сопряжения должен быть согласован с формой сопря-
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гаемых поверхностей. Так, например, две плоские поверхности не 
сопрягаются «соосно». 

Второй аргумент – тип выравнивания. Каждой поверхности 
геометрической модели можно поставить в соответствие вектор нор-
мали или какой-либо характеристический вектор (например, ось). 
Тип выравнивания определяет взаимное расположение таких векто-
ров сопрягаемых поверхностей. Если тип выравнивания равен «0», 
векторы будут сонаправлены, если значение «1» – направлены  
в противоположные стороны. 

Тип выравнивания может принимать также значение «–1». В этом 
случае система сама определит тип выравнивания с учетом уже 
имеющихся сопряжений. Это полезно в случае сопряжения деталей 
по плоскостям и цилиндрическим поверхностям, как в приведенном 
выше примере. Направление нормали к плоскости очевидно, а на-
правления векторов осей отверстия и пальца – нет. Соответственно, 
не известно, какой тип выравнивания следует указать во втором со-
пряжении, чтобы оно согласовывалось с сопряжением поверхно-
стей. Поэтому в первую очередь следует сопрягать плоскости: тип 
выравнивания для них очевиден – «1». После этого можно сопря-
гать цилиндры с типом выравнивания «–1». 

Остальные аргументы не имеют в данном контексте принципи-
ального значения. С ними предлагается ознакомиться самостоятель-
но. Внимание следует обратить только на последний аргумент, зна-
чением которого в данном случае является переменная longstatus.  
В нее записывается целочисленный код ошибки, если таковая воз-
никла при создании сопряжения. 

В интерфейсе процедуры AddMate3 отсутствуют аргументы, ука-
зывающие на сопрягаемые объекты. Каждому обращению к процеду-
ре AddMate3 предшествуют два обращения к процедуре SelectByID2. 
Процедура эта выделяет графический объект, со свойствами, соот-
ветствующими заданным значениям аргументов – имя, тип, коорди-
наты и др. То есть сопрягаемые объекты не передаются в процедуру 
сопряжения аргументами, а должны быть предварительно выделены. 

 
3.4. Процедура сопряжения 

 
Для ознакомления с особенностями сопряжения компонента сбор-

ки предлагается следующий вариант процедуры: 
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Sub MateLearning() 
Set swApp = Application.SldWorks 
Set Part = swApp.ActiveDoc 
Dim myMate As Object 
Dim longstatus As Long 
Dim Tm As Long 
Dim Ta As Long 
Tm=0 
Ta=1 

Set myMate = Part.AddMate3(Tm, Ta, False, 0.0, 0.1, 0.1, 0.01, 0.001, 
0, 0.5, 0.5, False, longstatus) 

Part.ClearSelection2 True 
Part.EditRebuild3 
End Sub 

 

Варьируя значениями переменных Tm и Ta, установить различ-
ные виды сопряжений. Сопрягаемые поверхности при этом выделя-
ются предварительно до запуска процедуры. 

При выполнении процедуры следует обратить внимание на зави-
симость между типом сопряжения и формой сопрягаемых поверх-
ностей, а также на количество предварительно выделенных граней. 

Установить последовательно два сопряжения2 между одной и той 
же парой компонентов: совпадение плоскостей и концентричность, 
варьируя при этом типами их выравнивания, Ta. 

 
4. ИЗВЛЕЧЕНИЕ ИНФОРМАЦИИ ИЗ ГЕОМЕТРИЧЕСКИХ 

МОДЕЛЕЙ В ТВЕРДОТЕЛЬНОМ ФОРМАТЕ 
 

4.1. Цель работы и решаемые задачи 
 

При решении многих конструкторских задач необходима геомет-
рическая информация, которая уже содержится в модели в ее теку-
щем состоянии. Анализ этой информации в ряде случаев позволяет 

                                                      
2 Для этого можно дважды выполнить процедуру, предварительно вы-

деляя каждый раз новую пару поверхностей. Можно также в одной проце-
дуре сделать два сопрягающих фрагмента. При этом перед вторым обра-
щением к методу AddMate определить точку паузы (breakpoint), во время 
которой выделить вторую пару граней. 
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избавить пользователя от избыточных операций ввода, повысив тем 
самым эффективность системы. Однако, прежде, чем анализировать, 
эту информацию необходимо извлечь из геометрической модели.  

В настоящее время наиболее распространенной формой описания 
технических систем считается модель в формате STEP (STandard 
for Exchange of Product model data). Данный формат позволяет описать 
весь жизненный цикл изделия, включая технологию изготовления  
и контроль качества продукции. И, что самое важное, он поддержи-
вает полноценное представление геометрии объекта – так называе-
мую, твердотельную модель (SolidModel). Твердотельное моделиро-
вание поддерживается также всеми современными геометрическими 
системами, используемыми при конструировании. 
Цель работы: освоение методов и средств доступа к элементам 

твердотельных геометрических моделей и извлечения доступной 
информации. Для достижения поставленной цели предлагается ре-
шить следующие задачи: 

 ознакомиться с общей структурой твердотельной модели; 
 изучить средства доступа к элементам этой структуры; 
 разработать программные средства выполнения конструктор-

ских процедур, использующих геометрическую информацию. 
Средства поиска и анализа граней предлагается изучать на при-

мере вставки внешнего компонента – цилиндрического пальца с бур-
тиком, LocatingPin, в сборочную модель, содержащую деталь с от-
верстием, TestAssm. 

Предполагается, что документ TestAssm открыт и активен. Поль-
зователь указывает в модели TestAssm две грани для сопряжения  
и запускает процедуру, которая вставляет LocatingPin в TestAssm  
и устанавливает два сопряжения между элементом и моделью – 
совпадение плоскостей и концентричность цилиндров (рис. 4.1). 

 
4.2. Твердотельная модель 

 
Для конструкторского проектирования и его автоматизации наи-

больший интерес представляют две части твердотельной модели: 
конструктивная геометрия и граничное представление. 

Конструктивная геометрия (constructive solid geometry – CSG) – 
множество объемных примитивов, соединенных бинарными теоре-
тико-множественными операциями. Примитив (Entity) – элемен-
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тарный объект. Соответственно, объемный примитив может пони-
маться как геометрическая простейшая фигура – призма, цилиндр, 
шар и т. п. Обобщение этого – тело, построенное протягиванием 
плоского контура S вдоль траектории T 

3 (рис. 4.2). 
 

 
 

Рис. 4.1. Граничное представление 
детали 

 
 

Рис. 4.2. Схема построения объемного 
примитива 

 
Теоретико-множественные операции: объединение (union), пе-

ресечение (intersection), вычитание (subtraction). То есть, прими-
тивы объединяются между собой, вычитаются один из другого либо 
пересекаются. Таким образом, сложные тела деталей получаются 
комбинированием объемных примитивов. 

Кроме объемных примитивов конструктивная геометрия вклю-
чает такие объекты, как системы координат, вспомогательную (или 
справочную, reference) геометрию и т. п. В каждом документе 
SolidWorks, например, присутствуют три взаимно перпендикуляр-
ные плоскости «сверху» (top), «справа» (right), «спереди» (front),  
а также объект «исходная точка» (origin). Эти объекты определяют 
систему координат, с одной стороны, а с другой – каждый из них 
является справочной (reference) плоскостью (точкой), используемой 
для геометрических построений. Пользователь может также сам 
создавать аналогичные вспомогательные объекты. 

                                                      
3 В геометрических системах определен более широкий набор способов 

построения и, соответственно, больше классов объемных примитивов: 
«Выдавливание» (Extrusion), «Вращение» (Revolved) и т. д. Однако эти опе-
рации сводятся к контуру и траектории: в первом случае траектория – век-
тор, во втором – дуга (спин-вектор). 
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Выражения, описывающие параметры модели, зависимости меж-
ду размерами, связи размеров с параметрами, также относятся к конст-
руктивной геометрии. 

Таким образом, конструктивная геометрия отражает последова-
тельность построения геометрической модели, ее структуру и спо-
соб построения. В системах геометрического моделирования кон-
структивная геометрия отображается в виде древовидной структуры 
(Feature manager design tree) рядом с графическим полем. 

Конструктивная геометрия создается пользователем. Каждый ее 
элемент является уникальным свойством и имеет собственное имя4. 
По этому имени свойство может быть найдено в структуре модели. 

Граничное представление (Boundary REPresentation – BREP) – 
метод представления объемной формы путем описания ее границ. 

Границы тела – это грани, границы граней – это ребра, грани-
цы ребер – вершины. Очевидно, что смежные грани будут иметь 
общие ребра, смежные ребра – общие вершины. Подобную струк-
туру удобно представлять в виде графа5: 

 
G = (V, E), 

 
где V – множество вершин, Е – множество ребер. Например, V – 
множество граней, тогда Е – множество ребер (то есть ребрам графа 
соответствуют ребра геометрической модели). 

Граничное представление генерируется системой исходя из кон-
структивной геометрии. Элементы граничного представления не 
имеют индивидуальных отличительных признаков (например, соб-
ственных имен). Выделить их можно только посредством анализа 
их свойств – форм, размеров и др. 

 
4.3. Доступ к элементам твердотельной модели 

 
Под элементами твердотельной модели в данном контексте под-

разумеваются свойства конструктивной геометрии и грани гра-
ничного представления. Первые – это объекты класса Feature, 

                                                      
4 Имена эти генерируются системой и могут быть указаны проекти-

ровщиком. 
5 Теория графов. 
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вторые – объекты класса Face2. И те, и другие доступны из-под 
компонента, содержащего этот элемент. 

В рамках данной работы можно взять любой компонент. Полный 
перечень всех компонентов текущей сборки Comps возвращает ме-
тод GetComponents: 

Comps = Asm.GetComponents(True), 
где Asm – ссылка на объект класса AssemblуDoc6. 

Перечень Comps возвращается в виде обычного одномерного 
массива, из которого выбирается любой элемент: 

SetComp = Comps(i). 
Переменная Comp должна быть объявлена как Component2 или 

как Object. 
Ссылка на свойство конструктивной геометрии может быть по-

лучена, в частности, методом FeatureByName непосредственно из 
компонента: 

SetFeature = Comp.FeatureByName(<имя_свойства>). 
Для получения доступа к элементам граничного представления 

необходимо сначала извлечь так называемое тело модели – объект 
класса Body2 компонента: 

SetCompBody = Comp.GetBody. 
Body2 – это своего рода коллектор, в котором сосредоточена вся 

граничная геометрия – грани, ребра, вершины и др. При помощи 
метода GetFaces извлекается массив граней компонента: 

CompFaces = CompBody.GetFaces. 
Каждый из элементов возвращаемого массива – объект класса 

Face2. 
Поскольку грани, как отмечалось ранее, собственных имен не 

имеют, в той или иной ситуации для выбора нужной следует анали-
зировать их свойства. 

Следует отметить, что часть свойств грани связана с поверхно-
стью, участком которой эта грань является. Это, например, уравне-
ния плоскости, оси и радиусы цилиндрических (конических) по-
верхностей и т. п. Эти свойства доступны из объекта класса Surface, 
возвращаемого методом GetSurface класса Face: 

SetSurface = Face.GetSurface. 

                                                      
6 Может быть получена как ссылка на текущий документ, см. преды-

дущие работы. 
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Ознакомиться со свойствами граней и поверхностей предлагается 
самостоятельно, используя справочник по API системы SolidWorks. 

 
4.4. Использование геометрической информации 

в процедурах 
 

В качестве практического примера использования геометрических 
свойств объектов предлагается развитие процедуры сопряжений.  

 
Sub main() 
Set swApp = Application.SldWorks 
Set Part = swApp.ActiveDoc 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1172, –0.0246, 
–0.0042, True, 1, Nothing, 0) 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1631, –0.0043, 
0.0613, True, 1, Nothing, 0) 
Dim myMate As Object 
Set myMate = Part.AddMate3(0, 1, False, 0.01, 0, 0, 0.01, 0.01, 0, 0.5, 
0.5, False, longstatus) 
Part.ClearSelection2 True 
Part.EditRebuild3 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1711, –0.00752, 
–0.0126, True, 1, Nothing, 0 
boolstatus = Part.Extension.SelectByID2("", "FACE", 0.1482, –0.0284,  
–0.0073, True, 1, Nothing, 0) 
Set myMate = Part.AddMate3(1, 1, False, 0.01, 0, 0, 0.01, 0.01, 0, 0.5, 
0.5, False, longstatus) 
Part.ClearSelection2 True 
Part.EditRebuild3 
End Sub 

 
Сопрягаемые элементы попарно выделяются перед обращением 

к методу AddMate3. В приведенном фрагменте для выделения исполь-
зуется метод SelectByID2 – интерактивное выделение посредством 
указания объекта в определенной точке, координаты которой переда-
ются как аргументы. Вычислить точку на объекте в общем случае не 
просто. Кроме того, если объект известен, то нет нужды искать на нем 
точку, его можно выделить непосредственно методом Select: 



 

32 

Part.ClearSelection2 True 
Object1ForMate.Select True 
Object2ForMate.Select True 
Set myMate = Part.AddMate3(Tm, Ta, False, 0.01, 0, 0, 0.01, 0.01, 

0, 0.5, 0.5, False, longstatus) 
 
Переменные Object1ForMate и Object2ForMate – ссылки на со-

прягаемые элементы геометрических моделей. В данном качестве 
могут выступать элементы справочной (вспомогательной) геомет-
рии либо грани. Первые являются элементами конструктивной гео-
метрии, вторые – граничного представления. Доступ и к тем, и к дру-
гим рассматривался в разделе 0. Используя приведенный материал, 
предлагается установить различные варианты сопряжений, а также 
различные их сочетания. 
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ВВЕДЕНИЕ 
 
Балочные конструкции получили широкое распространение во 

всех направлениях строительства и являются распространенным 
конструктивным решением сооружений из металлоконструкций. 
Такая конструкция может состоять из трубчатых элементов, прокат-
ных уголков, швеллеров и балок с другими сечениями. При модели-
ровании балочной конструкции в конечно-элементной среде ANSYS 
Workbench 14.0 каждый стержень представлен элементом BEAM188 
по умолчанию. В случае необходимости добавления тросов в конст-
рукцию используется конечный элемент типа LINK180. 

В качестве примера балочной конструкции взят башенный кран. 
Он используется на крупных стройплощадках и объектах, где тре-
буются большие объемы строительных либо монтажных работ, ско-
рость и высокая производительность. 

 
1. ОПИСАНИЕ КОНСТРУКЦИИ 

 

 
 

Рис. 1.1. Башенный кран КБ-403 
 

Башенный кран КБ-403 (рис. 1.1) 
является самомонтирующимся гру-
зоподъемным агрегатом с электри-
ческим управлением, способным 
передвигаться на колесно-рельсо-
вом ходу. Он оснащен подвижной 
балочной стрелой, закрепленной на 
такой же решетчатой поворотной 
башне, и управляемой посредством 
системы канатов. 

Башня состоит из нескольких 
выдвижных секций с разборной го-
ловной секцией и возможностью 
подращивания снизу. Балочная стре-
ла имеет также секционную конст-
рукцию. 

Основные технические характеристики башенного крана: 
– высота в свободном положении 37,9–54,7 м; 
– база секций 1,8 м; 
– количество секций башни до 5-ти штук;  
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– общая масса конструкции 76,6–80,5 т;  
– масса противовеса: 30 т; 
– вылет стрелы (минимальный/максимальный) 5,6/30 м; 
– вылет стрелы при максимальном грузоподъеме 16,5 м;  
– максимальная грузоподъемность 8 т; 
– грузоподъемность при максимальном вылете стрелы 3 т;  
– максимальный грузовой момент 120 т  м.  
На кран, находящийся на строительной площадке, действуют си-

лы и моменты со стороны груза, ветровые нагрузки, силы инерции 
движущихся частей, нагрузки от уклона, сила гравитации, которая 
зависит от собственной массы крана. 

Проверка устойчивости крана производится в соответствии с нор-
мами расчета по ГОСТ 13994-68 для двух случаев: при работе кра-
на (грузовая устойчивость) и в нерабочем состоянии (собственная 
устойчивость). 

Устойчивость крана определяют для наиболее неблагоприятных 
условий его работы. При проверке собственной устойчивости крана 
считают, что на него действуют ветровые нагрузки нерабочего со-
стояния в сторону противовеса, кран стоит на уклоне (в сторону 
опрокидывания) без груза. При расчете грузовой устойчивости кра-
на предполагают, что кран поднимает груз, равный его грузоподъ-
емности на данном вылете, при этом груз имеет максимально воз-
можную площадь; ветровые нагрузки рабочего состояния действу-
ют со стороны противовеса, кран стоит на уклоне (в сторону груза). 
Для проверки устойчивости при внезапном снятии нагрузки счита-
ют, что кран располагается на уклоне в сторону опрокидывания, 
нагрузка на крюке принимается направленной вверх, а ветровая 
нагрузка рабочего состояния направлена со стороны стрелы. 

Одна из особенностей расчета несущих конструкций башенных 
кранов заключается в определении деформаций и частот собствен-
ных колебаний. По японским нормам сейсмическая нагрузка учи-
тывается в нерабочем состоянии при отсутствии ветра [6–8]. 

 
2. ПОСТАНОВКА ЗАДАЧИ 

 
Цель работы: построить модель башни крана согласно заданным 

параметрам и произвести расчет напряженно-деформированного со-
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стояния конструкции и грузовой устойчивости крана с учетом боль-
ших перемещений (рис. 2.2). 

 

 
 

Рис. 2.2. Башенный кран КБ-403 
 
Геометрическая часть модели башенного крана состоит из сек-

ционной части, оголовка башни, горизонтальной площадки для уста-
новки навесной кабины, верхнего распора и упрощенной системы 
тросов и полипласта. 

Секционная часть включает в себя шесть секций. Каждая секция 
представляет собой балочную конструкцию высотой 6 м, длиной  
и шириной по 1,8 м. Секция состоит из четырех вертикальных сталь-
ных полых труб, в дальнейшем – стойки секции, диаметром 140 мм 
и толщиной стенки 8 мм, стальных полых труб раскосов диаметром 
60 мм и толщиной стенки 5 мм. В верхней части секции имеется 
горизонтальная площадка, выполненная из равнополочных сталь-
ных уголков с высотой полки 50 мм и толщиной 6 мм. 
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В верхней части башни для установки навесной кабины на высо-
те 34 м имеется горизонтальная площадка, выполненная из сталь-
ных швеллеров высотой 100 мм, шириной полки 50 мм, толщиной  
8 мм. Также в верхней части башни присутствует горизонтальный 
распор, расположенный на высоте 36 м и выполненный из стальных 
полых труб диаметром 140 мм и толщиной стенки 8 мм. Оголовок 
башни представляет собой рамную конструкцию из стальных полых 
труб диаметром 140 мм и толщиной стенки 8 мм. Система тросов  
и полиспласта упрощена и заменена двумя стальными тросами диа-
метром 40 мм, один из которых соединяет вершину оголовка башни 
с дальним концом распора, а второй соединяет дальний конец рас-
пора с противовесом. 

Все компоненты выполнены из конструкционной стали, с моду-
лем упругости 200 000 МПа (2  1011 н/м2) и коэффициентом Пуас-
сона равным 0,33. Плотность материала равна 7850 кг/м3. 

Нагрузки, приложенные к конструкции, включают вес самой баш-
ни, вес стрелы 2000 Н, вес груза 8000 Н, вес кабины 650 Н, силу от 
ветровой нагрузки 10 000 Н, действующей на башню со стороны про-
тивовеса, и силу от ветровой нагрузки 800 Н, действующей на груз. 

В дальнейшем значения геометрических параметров переводятся 
в систему измерения СИ и все вычисления проводятся в системе 
измерения СИ. 
 

3. ПОСТРОЕНИЕ ГЕОМЕТРИЧЕСКОЙ МОДЕЛИ  
БАШНИ КРАНА 

 
Модель башенного крана имеет шесть одинаковых секций. Каж-

дую секцию можно представить три раза повторяющейся частью. 
Геометрическую модель конструкции будем строить следующим 

образом: 
– построим повторяющуюся часть секции; 
– построим одну секцию из трех повторяющихся частей секции; 
– построим всю секционную часть башни (шесть секций); 
– построим площадку под навесную кабину; 
– построим оголовок башни; 
– построим верхний распор башни; 
– построим тросы башни. 
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3.1. Создание блока геометрии на схеме проекта 
 
Для исследования конструкции используется пакет ANSYS 14.0. 
Запустите модуль Workbench 14.0:  
Пуск > Все программы > ANSYS 14.0 > Workbench 14.0.  
Открывшееся окно приложения содержит следующие элементы: 
– MainMenu: главное меню приложения с пунктами File, Edit, 

View, Tools, Units, Help; 
– Tool Menu: содержит пункты New, Open, Save, …; 
– Toolbox: окно слева, которое содержит разделы с доступными 

анализами AnalysisSystems, компонентами Component Systems, поль-
зовательскими компонентами Custom Systems, компонентами опти-
мизации Design Exploration; 

– ProjectSchematic: главное окно со схемой проекта (рис. 3.1). 
 

 
 

Рис. 3.1. Основное окно программы  
 
При необходимости сбросьте настройки отображения окон, вер-

нув их в положение по умолчанию: 
{Main Menu} > View > Reset Window Layout. 
Перетащите компонент Geometry в разделе Toolbox > Component-

Systems на окно со схемой проекта, зажав левую клавишу мыши 
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(отпустите клавишу мыши на том месте, где появится красная рамка). 
В схеме проекта добавится блок А: Geometry (рис. 3.2).  
 

 
 

Рис. 3.2. Создание схемы проекта 
 

Дважды щелкните по ячейке А2: Geometry со знаком вопроса. За-
пустится модуль для построения геометрии DesignModeler. Выбери-
те метры в качестве единицы измерения (рис. 3.3). 

 

 
 

Рис. 3.3. Система единиц 
 

Изучите ToolMenu модуля DesignModeler. Обратите внимание на 
следующие кнопки, отмеченные на рис. 3.4. 
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Рис. 3.4. ToolMenu модуля DesignModeler: 
1 – поворот и перемещение конструкции в окне; 2 – ограничение выбора точки / 

линии / поверхности / объема; 3 – окно управления параметрами;  
4 – создание точки; 5 – выполнение действия 

 

При необходимости сбросьте настройки отображения окон, вер-
нув их в положение по умолчанию: 

{MainMenu} > View > Windows > ResetLayout. 
 

3.2. Определение сечений стержней 
 
Заранее создадим сечения для стержневых элементов конструк-

ции башни. 
Для создания сечения полой вертикальной трубы стойки выбе-

рите команду (рис. 3.5): 
{MainMenu} > Concept > Cross Section > Circular Tube.  
 

 
 

Рис. 3.5. Задание сечений 
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Задайте размеры согласно рис. 3.6. Для создания сечения полой 
трубы раскоса выберите снова команду: 

{MainMenu} > Concept > Cross Section > Circular Tube.  
Задайте размеры согласно рис. 3.7. 
 

 
Рис. 3.6. Размеры сечения 

трубы пояса 

 
 

Рис. 3.7. Размеры сечения 
трубы раскоса 

 
Для создания сечения стержней верхней площадки секции в виде 

уголка выберите команду: 
{MainMenu} > Concept > Cross Section > L Section.  
Задайте размеры согласно рис. 3.8. 
Для создания сечения стержней площадки под кабину в виде 

швеллера выберите команду: 
{MainMenu} > Concept > Cross Section > Channel Section.  
Задайте размеры согласно рис. 3.9. 
 

 
Рис. 3.8. Размеры сечения 

уголка площадки

 
Рис. 3.9. Размеры сечения  
швеллера площадки кабины
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Для создания сечения троса в виде круга выберите команду: 
{MainMenu} > Concept > CrossSection > Circular. 
Задайте размеры согласно рис. 3.10. 
 

 
Рис. 3.10. Размеры сечения троса

 
Созданные сечения добавлены в узел CrossSections дерева моде-

ли (рис. 3.11).  
 

 
Рис. 3.11. Узел сечений

 
3.3. Создание параметрической геометрической модели 

 
3.3.1. Построение отдельной секции 

 
Заметим, что каждую секцию можно представить повторяющей-

ся три раза частью. Если высоту секции принять за h, то высота по-
вторяющейся части – h/3. Построение секции начнем с одной по-
вторяющейся части секции. Полную отдельную секцию получим 
путем копирования данной части секции два раза. 

Шаг 1: Создание основных параметров построения секции. 
Нажмите на кнопку , чтобы открыть окно управления 

параметрами ParameterManager. Данное окно содержит четыре вклад-
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ки: DesignParameters (определение параметров для построения), 
Parameter/DimensionAssignments (присвоение значений геометри-
ческим размерам), Check (проверка, подтверждение изменений), 
Close (закрытие окна). В первой вкладке DesignParameters задаем 
значения переменных (рис. 3.12): 

a = 0,9 – половина ширины / длины секции; 
h = 6 – высота секции; 
n = 5 – количество повторов секций. 

 

 
 

Рис. 3.12. Задание параметров 
 

Шаг 2: Создание базовых точек повторяющейся части секции. 
Нажмите на кнопку  (рис. 3.4), чтобы создать точку. Слева 

внизу откроется окно со свойствами. Поле Type содержит значение 
Construction Point, поле Definition – значение Manual Input.  

В поле FD8, XCoordinate слева есть чекбокс, отметьте его. При 
этом в нем отобразится латинская буква D. Появится окно, предла-
гающее ввести имя параметра. Введите а, нажмите OK (рис. 3.13). 

 

  
 

Рис. 3.13. Создание точки 
 

Аналогичным образом в поле FD9, YCoordinate отметьте чекбокс, 
в окне введите а, нажмите OK.  
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Нажмите кнопку . Построена точка Point 1 (рис. 3.14). 
 

   
 

Рис. 3.14. Созданная точка Point 1 
 
Вкладка Parameter / Dimension Assignments примет вид (рис. 3.15). 
 

 
 

Рис. 3.15. Вкладка Parameter/Dimension Assignments 

 

 
 

Рис. 3.16. Свойства точки 

Далее создайте еще семь точек 
со значениями координат по умол-
чанию. Нажмите на кнопку , 
чтобы создать очередную точку. 
Проверьте свойства (рис. 3.16). 
Нажмите кнопку . По-
вторите семь раз, чтобы получить 
восемь точек. 

Откройте вкладку Parameter / Dimension Assignments и допишите 
значения геометрических параметров (координат) следующим обра-
зом (рис. 3.17). 
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Рис. 3.17. Вкладка Parameter / Dimension Assignments 
 
 

 
 

Рис. 3.18. Созданные точки 

Обратите внимание, что для 
точек 5, 6, 7, 8 добавлен пара-
метр FD10 для координаты Z. 

Нажмите на вкладку Check. 
Нажмите кнопку . 
Построенные точки отображе-
ны на рис. 3.18. 
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Рис. 3.19. Команда создания линии 

Шаг 3: Создание базовых ли-
ний повторяющейся части сек-
ции. Для создания линий по точ-
кам выберите команду (рис. 3.19): 

{MainMenu} > Concept > Lines 
FromPoints. 

Постройте по созданным точ-
кам следующие линии: щелчком 
мыши выберите точку 1, зажмите 
клавишу Ctrl, щелчком мыши вы-
берите точку 5, отпустите Ctrl. 
Аналогично соедините точки 2–6, 
3–7, 4–8.  

В окне свойств нажмите Apply в поле PointSegments (рис. 3.20). 
Нажмите кнопку . Созданы четыре линии (рис. 3.21). 
Слева в дереве модели в узле Parts, Bodies появилось 4 LineBody. 
Переименуйте данные стержни из LineBody в Base1, Base2, Base3, 
Base4 соответственно порядку (рис. 3.22). 

 

 
 
 

Рис. 3.20. Свойства Line1 

 
 

Рис. 3.21. Созданные 
линии 

 
 
 

Рис. 3.22. Дерево 
модели

 
Далее необходимо разбить на две равные части две накрест ле-

жащие линии. При этом делении в дерево модели не будет добавле-
но ни новых LineBody, ни новых Point, однако срединная точка  
и новые части деленной линии будут доступны для выделения. 

Для разбиения нужных линий пополам выберите: 
{MainMenu} > Concept > SplitEdges. 
Выберите две линии, показанные на рис. 1.23, в окне свойств  

в поле Edges нажмите Apply. В поле Definition поставьте значение 
Fractional, в поле FD1, Fraction – значение 0,5 (рис. 1.24). 
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Нажмите . 
 

 

 

Рис. 3.23. Выбранные линии  
для разбиения пополам

 

Рис. 3.24. Свойства разбиения линии 

 

Далее построим линии раскосов. Чтобы новые линии не объеди-
нились с уже построенными линиями в одно тело LineBody и было 
возможно задать линиям отличные сечения, необходимо при по-
строении линий указывать операцию AddFrozen, а не AddMaterial. 

Для построения линий раскосов по точкам выберите команду: 
{MainMenu} > Concept > LinesFromPoints. 
Постройте линии, как показано на рис. 3.25. Поочередно соеди-

няйте точки, не забывая удерживать клавишу Ctrl. Наметив все не-
обходимые линии, в окне свойств в поле PointSegments нажмите 
Apply. В поле Operation выберите AddFrozen (рис. 3.26). Нажмите

. В дереве модели в узле Parts, Bodies появилось новое 
тело LineBody, представляющее собой набор раскосов (рис. 3.27). 

 

 
 

Рис. 3.26. Свойства линии 
 

 

Рис. 3.25. Созданные линии раскосов
 

Рис. 3.27. Дерево модели
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Шаг 4: Определение сечений стержней. 
Припишем теперь построенным линиям нужные сечения. Выде-

лите четыре вертикальные линии, представляющие стойки секции. 
В дереве модели это первые четыре узла Base1, Base2, Base3, Base4. 
В окне свойств в поле CrossSection выберите сечение CircularTube1 
(рис. 3.28). 

 

 
 

Рис. 3.28. Задание сечения вертикальным стойкам 
 

Выделите оставшееся LineBody в дереве модели, которое пред-
ставляет собой раскосы секции, и задайте для них в окне свойств  
в поле CrossSection сечение CircularTube2. 

Шаг 5: Построение полной отдельной секции. 
Полная секция состоит из трех повторяющихся частей.  
Для копирования повторяющейся части секции выберите коман-

ду (рис. 3.29): 
{MainMenu} > Create > Pattern. 
 

 
 

Рис. 3.29. Команда Pattern 
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Рис. 3.30. Свойства команды Pattern 

В окне свойств команды 
(рис. 3.30) проверьте значение 
Linear в поле PatternType – ко-
пирование линейно в заданном 
направлении. 

Выделите все построенные 
тела секции нажмите в окне 
свойств Apply в поле Geometry. 

В дереве модели выделите узел ZXPlane (рис. 3.31). Чтобы мож-
но было выбрать ось Z в качестве направляющей для копирования, 
щелкните по пунктирной оси в графическом окне, соответствующей 
этой оси (рис. 3.32). Нажмите в окне свойств Apply в поле Direction. 

В поле FD1, Offset (рис. 3.33) отметьте чекбокс, в окне введите h, 
нажмите OK. Откройте вкладку Parameter / DimensionAssignments  
и измените значение параметра на @h/3 (рис. 3.33). 

В поле FD3, Copies введите значение 2. Будет создано еще две 
копии построенной части секции, т. е. всего три повторяющиеся 
части.  

Нажмите . 
 

 
 
 
 

Рис. 3.31. Узел  
ZXPlane 

 
 

Рис. 3.32. Выбор 
направления

 
 
 

 
Рис. 3.33. Изменение 

параметра
 
Перейдем к построению горизонтальной площадки. 
Выберите команду {MainMenu} > Concept > LinesFromPoints  

и создайте линии площадки, как показано на рис. 3.34, выбрав нуж-
ные точки с помощью мыши. Отметим все создаваемые линии.  
В окне свойств в поле PointSegments нажмите Apply. В поле Opera-
tion выберите AddFrozen. 

Нажмите . 
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Рис. 3.34. Построение площадки 
 

Выделите новое тело LineBody в дереве модели, которое пред-
ставляет собой площадку, и задайте ему в окне свойств в поле 
CrossSection сечение L1.  

 

 
Рис. 3.35. Узел Plos1

Переименуйте тело в Plos1. 
Для отображения на модели 

сечений стержней выберите пункт 
меню {MainMenu} > View > 
Cross Section Solids. 

Проверьте, чтобы уголки пло-
щадки были ориентированы 
внутрь-вверх.  

1. Нажмите левой кнопкой 
мыши в дереве модели по узлу 
Plos1 (рис. 3.35). 

2. В данном теле Plos1 выде-
лите отдельный стержень. Для 

этого нажмите кнопку , а за-
тем нажмите на нужный стер-
жень. Он подсветится зеленым 
цветом (рис. 3.36). 
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Рис. 3.36. Выбранный стержень 
 
3. Выберите в выпадающем списке пункт "Selection" (а не 

"Vector") (рис. 3.37). 
 

 
 

Рис. 3.37. Выбран пункт "Selection" 
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4. Нажмите кнопку , а затем нажмите на стержень, ортого-
нальный по отношению к стержню, сечение которого следует по-
вернуть (рис. 3.38). Он подсветится зеленым цветом. 

 

 
 

Рис. 3.38. Выбран срержень, ортогональный к поворачиваему 
 

5. В появившемся окне свойств измените угол поворота в поле 
Rotate (рис. 3.39). Нажмите "Enter". 

 

 
 

Рис. 3.39. Проверка ориентации сечения 
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3.3.2. Построение секционной части башни 
 

 
 

Рис. 3.40. Секционная часть 
башни 

Для построения секционной части 
башни выберите команду:  

{MainMenu} > Create > Pattern. 
Выделите все построенные тела сек-

ции и нажмите в окне свойств Apply  
в поле Geometry. 

В дереве модели выделите узел 
ZXPlane, выберите ось Z в качестве на-
правляющей, нажмите в окне свойств 
Apply в поле Direction. 

В поле FD1, Offset отметьте чекбокс, 
в окне введите h, нажмите OK.  

В поле FD3, Copies отметьте чекбокс, 
в окне введите n, нажмите OK. 

Нажмите . 
Результат построения представлен на 

рис. 3.40. Если графическое отображе-
ние башни долго не появляется, отклю-
чите отображение сечений стержней. 

 
3.3.3. Построение площадки под навесную кабину 

 

 
 

Рис. 3.41. Верхняя площадка  
башни 

Для построения площадки под 
навесную кабину выберите команду: 

{MainMenu} > Create > Pattern. 
Выделите верхнюю площадку 

башни (рис. 3.41) и нажмите в окне 
свойств Apply в поле Geometry. 

Выберите ось Z в качестве на-
правляющей, измените направление 
копирования , нажмите в окне 
свойств Apply в поле Direction. 
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Рис. 3.42. Площадка  
под кабину 

 

 
 

Рис. 3.43. Точки площадки  
под кабину 

В поле FD1, Offset введите 2 (что 
соответствует копированию объекта 
двумя метрами ниже по оси Z). 

В поле FD3, Copies введите 1. 
Нажмите . Полученная 

площадка отображена на рис. 3.42. 
Переименуйте полученное тело из 
четырех стержней из LineBody в 
CabinFloor. 

Постройте две дополнительные 
точки площадки под кабину – Point9 
и Point10. Нажмите на , что-
бы создать точку. Измените поле 
Definition – значение ManualInput. 
Нажмите . Повторите. 

Откройте вкладку Parameter / Di-
mensionAssignments и измените зна-
чение параметра на: 
Point10.FD10 = @h * (@n + 1) – @h/3 
Point10.FD9 = @a + 2 
Point10.FD8 = –@a 
Point9.FD10 = @h * (@n + 1) – @h/3 
Point9.FD9 = @a + 2 
Point9.FD8 = @a 

Нажмите . Результат по-
строения представлен на рис. 3.43. 

Выберите команду для построения линий:  
{MainMenu} > Concept > LinesFromPoints.  
Соедините точки согласно рис. 3.44. 
В поле Operation выберите AddFrozen. Нажмите . 
Выберите в дереве проекта два тела, представляющие семь стерж-

ней площадки, задайте сечение Channel1 (рис. 3.45). 
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Рис. 3.44. Площадка под кабину

 
 

 
 
 

Рис. 3.45. Сечение площадки
 
Проверьте ориентацию сечений (рис. 3.46). 
 

 
 

Рис. 3.46. Ориентация сечений площадки 
 
Переименуйте полученное тело из трех стержней из LineBody  

в Cabin. 
 

3.3.4. Построение распора башни 
 
Постройте дополнительную точку распора – Point11. Нажмите 

на , измените поле Definition – значение ManualInput, нажмите 
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. Откройте вкладку Parameter / DimensionAssignments и из-
мените значение параметра: 
Point11.FD10 = @h * (@n + 1) 
Point11.FD8 =@a + 3 

Нажмите . 
 

 
 

Рис. 3.47. Верхний распор башни 

Выберите команду для по-
строения линий:  

{MainMenu} > Concept > 
LinesFromPoints. 

Соедините необходимые точ-
ки согласно рис. 3.47. В поле 
Operation выберите AddFrozen. 
Нажмите . 

Выберите стержни распора, 
задайте сечение CircularTube1. 

 

Переименуйте полученное тело из LineBody в Tale. 
 

3.3.5. Построение оголовка башни 
 

 
 

Рис. 3.48. Оголовок башни 

Постройте дополнительную точ-
ку распора – Point12. Нажмите на 

, измените поле Definition – 
значение ManualInput, нажмите 

. Откройте вкладку  
Parameter / DimensionAssignments 
и измените значение параметра: 
Point12.FD10 = @h * (@n + 1) + 5 

Нажмите . 
Соедините необходимые точки 

согласно рис. 3.48. В поле Operation 
выберите AddFrozen. Нажмите 

. 
 

Выберите четыре стержня оголовка, задайте сечение CircularTube1. 
Переименуйте полученное тело из LineBody в Head. 
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3.3.6. Построение тросов башни 
 

 
 

Рис. 3.49. Тросы 
башни 

Постройте дополнительную точку противо-
веса – Point13.  

Нажмите на , измените поле Definition – 
значение ManualInput, нажмите .  

Откройте вкладку Parameter / Dimension  
Assignments и измените значение параметра  
Point13.FD8 = @a + 5 

Нажмите . 
Выберите команду для построения линий: 
{MainMenu} > Concept > LinesFromPoints. 
Соедините точки Point11 и Point12. В поле 

Operation выберите AddFrozen. Нажмите 
. 

Переименуйте полученное тело из LineBody 
в CableHead. 

Снова выберите команду для построения ли-
ний. Соедините точки Point12 и Point13. В поле 
Operation выберите AddFrozen. Нажмите 

. 
Переименуйте полученное тело из LineBody  
в Cable. Результат отображен на рис. 3.49.  

 
3.3.7. Заключительный этап создания геометрии башни.  

Объединение всех тел в единую конструкцию 
 

 
 

Рис. 3.50. Связывание тел

В дереве модели в узле 34 Parts, 
34 Bodies выберите все тела, щелк-
ните правой клавишей мыши и вы-
берите FormNewPart, чтобы при 
создании конечно-элементной сет-
ки элементы имели общие узлы 
(рис. 3.50). 

Закройте модуль DesignModeler. 
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4. ПОСТРОЕНИЕ КОНЕЧНО-ЭЛЕМЕНТНОЙ МОДЕЛИ 
БАШНИ КРАНА И ПРОВЕДЕНИЕ СТАТИЧЕСКОГО  

АНАЛИЗА КОНСТРУКЦИИ 
 

4.1. Подготовка конечно-элементной модели башни 
 

4.1.1. Создание блока анализа на схеме проекта 
 

Перетащите компонент StaticStructural в разделе Toolbox > 
AnalysisSystems на ячейку А2: Geometry в схеме проекта. В схему 
проекта добавится блок B: StaticStructural (прил. 1). 

Дважды щелкните по ячейке B2: Engineering Data. Откроется 
окно с материалами, доступными в проекте (рис. 4.1). 

 

 
 

Рис. 4.1. Материалы проекта 
 
Просмотрите свойства материала по умолчанию – конструкцион-

ной стали. При необходимости можно добавить свой материал или 
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воспользоваться библиотекой материалов. Для возвращения к схеме 
проекта нажмите . 

Дважды щелкните по ячейке B4: Model для открытия модуля 
Mechanical. 

 
4.1.2. Учет навесной кабины на башне крана  

с помощью «точечной массы» 
 

 

Рис. 4.2. Добавление массы 

В дереве модели щелк-
ните правой клавишей 
мыши по узлу Geometry. 
Выберите (рис. 4.2):  

Insert > Point Mass. 

 
Выберите четыре стержня площадки под навесную кабину (из 

тела Cabin три стержня и из тела CabinFloor один стержень) и на-
жмите в окне свойств Apply в поле Geometry (рис. 4.3). Задайте ко-
ординаты X = 0, Y = 1,9 м, Z = 35 м, которые соответствуют центру 
тяжести кабины. В поле Mass введите значение массы кабины 650. 

В данном варианте для упрощения не учитываются моменты 
инерции массы. 

 

    
 

Рис. 4.3. Моделирование кабины точечной массой 
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4.1.3. Учет стрелы крана с помощью «удаленной точки» 
 

 
 

Рис. 4.4. Добавление выборки 

В дереве модели щелкни-
те правой клавишей мыши по 
главному узлу Model (B4). 
Выберите (рис. 4.4): 

Insert > NamedSelection. 
 

В дерево модели добавлен узел . 
Выберите четыре стержня верхней площадки и нажмите в окне 

свойств Apply в поле Geometry (рис. 4.5) в окне свойств узла Selection. 
 

    
 

Рис. 4.5. Создание именованной выборки 
 

Переименуйте узел Selection в Arrow . 
 

 
 

Рис. 4.6. Добавление удаленной точки

В дереве модели щелкни-
те правой клавишей мыши по 
главному узлу Model (B4). 
Выберите (рис. 4.6): 

Insert > RemotePoint. 

 

В дерево модели добавлен узел .  
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Измените свойства удаленной точки согласно рис. 4.7. Переиме-
нуйте из Remote Point в ArrowCenter. 

 

 
 

Рис. 4.7. Создание удаленной точки 
 

4.1.4. Учет ветровой нагрузки на кран 
 

 
 

Рис4.8. Выбор точек ветровой нагрузки

В дереве модели щелкните 
правой клавишей мыши по уз-
лу NamedSelections. Выберите  

Insert > NamedSelection. 
Выберите две точки, распо-

ложенные со стороны проти-
вовеса на верхней площадке  
5-й секции на высоте 30 м 
(рис. 4.8). 

Переименуйте узел Selection 
в H5 

 

 
4.1.5. Учет тросов крана 

 

 
 

Рис. 4.9. Добавление свойств элемента 

В дереве модели щелк-
ните правой клавишей мы-
ши по узлу Geometry >  
Cable. Выберите (рис. 4.9): 

Insert > Commands. 
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Трос моделируется при помощи конечного элемента типа 
LINK180. 

Вставьте следующий код: 
et,matid,180 
r,matid, 1.2566e-003, , 
Величина 1.2566e-003 равна площади сечения троса в м2. Дан-

ное значение можно увидеть, если выделить узел Geometry > Cable 
и в окне свойств просмотреть поле CrossSectionArea. 

Выполните аналогичные действия для узла Geometry > CableHead. 
Код идентичен предыдущему. 

При моделировании тросов стержень, представляющий трос, 
должен представляться в конечно-элементной сетке как один ко-
нечный элемент. Для этого в дереве модели щелкните правой кла-
вишей мыши по узлу Mesh. Выберите Insert > Sizing. Выберите два 
стержня Cable и CableHead. Нажмите в окне свойств Apply в поле 
Geometry. В поле Type выберите значение Number of Divisions,  
в поле Number of Divisions введите 1 (рис. 4.10). 

 

 
 

Рис. 4.10. Задание параметров для разбиения тросов  
на конечные элементы 

 
В дереве модели щелкните правой клавишей мыши по узлу Mesh 

и выберите GenerateMesh. 
При разбиении модели на конечные элементы, стальные стерж-

ни каркаса башни представлены по умолчанию элементами типа 
BEAM188, тросы – указанными нами для них элементами типа 
LINK180. 
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4.2. Задание граничных условий 
 

4.2.1. Закрепление опор башни 
 

 
 

Рис. 4.11. Выбор опор

В дереве модели щелкните правой кла-
вишей мыши по узлу StaticStructural (B5), 
выберите Insert > FixedSupport (рис. 4.12). 

Выберите 4 точки опоры (рис. 4.11), 
предварительно выбрав инструмент . 
Нажмите в окне свойств Apply в поле 
Geometry. 

 

 
 

Рис. 4.12. Задание граничных условий 
 

4.2.2. Собственный вес конструкции 
 

Для учета собственного веса конструкции в дереве модели щелк-
ните правой клавишей мыши по узлу StaticStructural (B5), выберите 
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Insert > StandardEarthGravity. Проверьте правильность направле-
ния гравитационной силы (–Z). 

 
4.2.3. Противовес 

 
В дереве модели щелкните правой клавишей мыши по узлу  

StaticStructural (B5), выберите Insert > Displacement. Выберите точ-
ку противовеса Point13 в качестве точки приложения ограниче-
ния. В полях XComponent, YComponent, ZComponent поставьте 0 
(рис. 4.13).  

 

      
 

Рис. 4.13. Задание силы противовеса 
 

4.2.4. Ветровая нагрузка 
 
Нормальное ветровое давление на препятствие в первом при-

ближении определяется по формуле 
 

2
0 0,5 ,w p v                                            (1) 

 

где v – скорость ветра, м/с, на высоте 10 м; 
 p – плотность воздуха, кг/м3, зависящая от его влажности, тем-

пературы и атмосферного давления; 
 0,5 – коэффициент сопротивления (обтекания). 
Ветровую нагрузку рассчитываем для скорости ветра 15 м/с при 

плотности воздуха 1,2 кг/м3. Учитываем изменение ветрового дав-
ления по высоте на 20 м; тип местности В – городские территории, 
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лесные массивы и другие местности, равномерно покрытые препят-
ствиями высотой более 10 м [9–10]. 

Скорость порывов ветра содержит постоянную составляющую, 
среднее значение скорости ветра и переменную составляющую, ко-
торую можно представить как сумму гармонических составляющих: 

 

ср пор1( ) ( ) sin( ),i kiiV t V t V t
                             (2) 

 

где ср( )V t  – сравнительно медленно меняющееся среднее значение 

скорости ветра, м/с; 
 пор iV  – амплитуда i-й составляющей скорости порыва ветра; 

 ki  – частота i-й гармонической составляющей скорости порыва 
ветра. 

Частота колебаний отдельных гармонических составляющих ско-
рости в порыве ветра: 

 

,k K                                               (3) 
 

где K находится из эмпирического выражения [6]: 
 
2,28
ср0,0038 порывов/c.K V                               (4) 

 

Для средней скорости 15 м/с частота k  = 5,73 рад/с. 

 
Рис. 4.14. Ветровая нагрузка 

В дереве модели щелкните пра-
вой клавишей мыши по узлу  
StaticStructural (B5), выберите  
Insert > Force, задайте свойства, 
как показано на рис. 4.14. 

Рассчитанная ветровая нагрузка 
округленно равна 10 000 Н и при-
кладывается к каждой из двух то-
чек выборки H5 в направлении, 
противоположном направлению 
оси OX. Так как прикладываемая 
нагрузка будет равномерно разде-
лена по двум точкам выборки, уве-
личим значение силы до –20 000 Н.  
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4.2.5. Нагрузка от поднимаемого груза 
 
В дереве модели щелкните правой клавишей мыши по узлу  

StaticStructural (B5), выберите Insert > RemoteForce. 

 
 

Рис. 4.15. Усилия со стороны груза 

Задайте свойства, как пока-
зано на рис. 4.15. Кран должен 
обеспечивать подъем массы 
8 000 кг при вылете стрелы на 
16,5 м. Учитывая массу груза, 
массу стрелы, значения удален-
ной силы в данной точке будут 
равны –100 000 Н в направле-
нии, противоположном оси OZ. 
Учитывая усилия от ветровой 
нагрузки на груз, значения уда-
ленной силы в данной точке 
будут равны –12 000 Н в на-
правлении, противоположном 
оси OX. 

 
4.3. Проведение статического анализа конструкции 

 
Перед решением задачи добавьте результаты для просмотра.  

В дереве модели щелкните правой клавишей мыши по узлу Solution 
(B6), выберите Insert > Deformation > Total (общие перемещения). 
Также можно добавить картины для продольной силы Axial force, 
поперечной силы ShearForce, изгибающего момента TotalBend-
ingMoment, момента кручения TorsionalMoment. 

 

 
 

Рис. 4.16. Выполненный расчет

 

Insert > BeamTool > BeamTool. 
BeamTool включает картины для осево-
го напряжения Directstress и полного 
(сложного) напряжения Combinedstress. 

Запустите расчет, щелкнув по кноп-
ке . Если расчет выполнен ус-
пешно, то возле добавленных результа-
тов в узле Solution (B6) появится зеле-
ная галочка (рис. 4.16). 
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Если в ходе расчета возникла ошибка, нажмите на узел Solution-
Information и найдите информацию по возникшей ошибке. 

На рис. 4.17 отображены суммарные перемещения узлов конст-
рукции. Вершина башни имеет наибольшее перемещение, которое 
равняется 0,32 м. 

На рис. 4.18 приведена картина максимальных комбинирован-
ных напряжений конструкции. При этом его наибольшее значение 
равняется 110 МПа (не превосходит предела текучести материала  
в 250 МПа), оно возникло в узле крепления распора. Наибольшее на-
пряжение сжатия возникло в опоре башни Base3 и равно –116 МПа, 
что также не превосходит предела текучести материала. Коэффициент 
запаса прочности по пределу текучести равен 2,16. 

 

 
 

Рис. 4.17. Картина суммарных 
перемещений конструкции

 
 

Рис. 4.18. Картина максимального 
полного напряжения конструкции

 
4.4. Анализ устойчивости конструкции 

 
Откройте схему проекта. Перетащите компонент LinearBuckling 

из раздела Toolbox > AnalysisSystems на ячейку В6: Solution в блоке 
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B: StaticStructural на схеме проекта (рис. 4.19). В схему проекта до-
бавится блок C: LinearBuckling (прил. 1). 

 

 
 

Рис. 4.19. Действие для создания нового анализа в проекте 
 
Дважды щелкните по ячейке С5: Setup в блоке C: LinearBuckling 

для запуска модуля. 
В настройках анализа LinearBuckling (С5) – Analysis Settings  

в поле MaxModestoFind можно задать число форм потери устойчи-
вости. Для просмотра формы потери устойчивости в конце расчета 
добавьте общее перемещение элементов модели. В дереве модели 
найдите узел LinearBuckling (С5), щелкните правой клавишей мы-
ши по узлу Solution (С6), выберите Insert > Deformation > Total. 
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Рис. 4.20. Первая форма потери 
устойчивости

Запустите расчет: по узлу  
LinearBuckling (С5) > Solution (С6) 
щелкните правой клавишей мы-
ши, выберите Solve. 

После выполнения анализа вы-
деляем в дереве узел Linear-
Buckling (С5) > Solution (С6) > 
TotalDeformation. В графическом 
окне отображается первая фор- 
ма потери устойчивости модели 
(рис. 4.20). В табличных данных 
появляется параметр LoadMultiplier, 
равный 3,66. LoadMultiplier пред-
ставляет собой коэффициент запа-
са устойчивости конструкции при 
потере устойчивости по первой 
форме. 

 

4.5. Модальный анализ 
 

Откройте схему проекта. Перетащите компонент из раздела 
Toolbox > AnalysisSystems на ячейку В6: Solution в блоке B: Static-
Structural на схеме проекта. В схему проекта добавится блок D: 
Modal (прил. 1). 

 

 
 

Рис. 4.21. Действие для создания нового анализа в проекте 
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Дважды щелкните по ячейке D5: Setup в блоке D: Modal для за-
пуска модуля. 

В настройках анализа Modal (D5) – AnalysisSettings в поле 
MaxModestoFind можно задать число искомых мод собственных 
колебаний. Для просмотра собственной формы колебаний в дереве 
модели найдите узел Modal (D5), щелкните правой клавишей мыши 
по узлу Solution (D6), выберите Insert > Deformation > Total. 

Запустите расчет: по узлу Modal (D5) > Solution (D6) щелкните 
правой клавишей мыши, выберите Solve. 

После выполнения анализа выделяем в дереве узел Modal (D5) > 
Solution (D6) > TotalDeformation. 

В графическом окне отображается первая форма собственных 
колебаний конструкции. В табличных данных появляются частоты 
первых шести мод. 

Выделите все строки в 
таблице, щелкните правой 
клавишей мыши, выберите 

CreateModeShapeResults 
(рис. 4.22). 

Получены следующие 
частоты собственных ко-
лебаний: для 1-й формы – 
0,993 Гц; для 2-й формы – 

1,382 Гц; для 3-й формы – 3,293 Гц; для 4-й формы – 4,625 Гц; для 
5-й формы – 5,21 Гц; для 6-й формы – 6,745 Гц. 

Обновите результаты: щелкните правой клавишей мыши по  
Solution (D6), выберите EvaluateAllResults. 

Первая частота собственных колебаний равна 0,993 Гц, а зна-
чит, ветра скоростью до 6 м/с не представляют опасности для кон-
струкции, в чем можно убедиться, используя формулы (2)–(4)  
из раздела 4.2.4 в предположении одной гармонической состав-
ляющей. Частота колебаний отдельной гармонической составляю-
щей скорости в порыве ветра для средней скорости 15 м/с равна  
k = 5,73 Гц. 

Первая, пятая и шестая формы собственных колебаний пред-
ставлены в формате 2xAuto в прил. 2 на рис. П2.1–П2.3. 

 
 

Рис. 4.22. Отображение форм
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4.6. Гармонический анализ 
 
Откройте схему проекта. Перетащите компонент Harmonic из 

раздела Toolbox > AnalysisSystems на ячейку D6: Solution в блоке B: 
Modal на схеме проекта (рис. 4.23). В схему добавится блок E: 
HarmonicResponse (прил. 1). Дважды щелкните по ячейке E5: Setup 
в блоке E: HarmonicResponse для запуска модуля. 

 

 
 

Рис. 4.23. Действие для создания нового анализа в проекте 
 
В настройках анализа HarmonicResponse (E5) – AnalysisSettings  

в поле RangeMinimum – 0,6 Гц, в поле RangeMaximum – 6,8Гц,  
в поле Solution Intervals – 20. 

В дереве модели щелкните правой клавишей мыши по узлу 
HarmonicResponse (E5), выберите Insert > Force, задайте свойства, 
как показано на рис. 4.24. 
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Рис. 4.24. Задаем силу 

Амплитуда скорости ветра 
25 м/с. Рассчитанная ветровая 
нагрузка округленно 16 000 Н  
и прикладывается к каждой из 
двух точек выборки h5 в направ-
лении, противоположном направ-
лению оси OX. Так как прикла-
дываемая нагрузка будет равно-
мерно разделена по двум точкам 
выборки, увеличим значение силы 
до –32 000 Н. 

 

Щелкните правой клавишей мыши по узлу Solution (Е6), выбе-
рите Insert > FrequencyResponse > Acceleration. 

 
 

Рис. 4.25. Точка площадки 

Выберите крайнюю даль-
нюю точку площадки под ка-
бину конструкции (рис. 4.25)  
и задайте остальные настройки 
согласно рис. 4.26. Выберите 
Insert > FrequencyResponse > 
Deformation. Выберите край-
нюю дальнюю точку площадки 
под кабину конструкции и за-
дайте остальные настройки со-
гласно рис. 4.27. 

 

 
 

Рис. 4.26. Вид настроек 

 
 

Рис. 4.27. Вид настроек 
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Запустите расчет: по узлу HarmonicResponse (E5) > Solution (Е6) 
щелкните правой клавишей мыши, выберите Solve. Просмотрите 
полученные результаты – графики Frequency Response (Acceleration) 
и Frequency Response (Deformation). 

На графике амплитуды деформации (рис. 4.28) можно заметить 
резонансные пики при частотах 1,53 Гц, 3,39 Гц, 5,25 Гц. 
 

 
 

Рис. 4.28. График амплитуды деформации для точки площадки 
 

Щелкните правой клавишей мыши по узлу Solution (Е6), выбе-
рите Insert > Deformation > Total. В окне свойств введите желае-
мую частоту колебаний, для которой должна быть отображена фор-
ма, например 1,53 Гц. Щелкните правой клавишей мыши по узлу  
TotalDeformation и выберите RetrieveThisResult. 
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ПРИЛОЖЕНИЕ 3 
 

Задания по вариантам 
 

Для видов секций, представленных на следующих рисунках, вы-
полните посторенние конструкции крана, считая, что используется 
три таких секции. Место для крепления кабины выберите самостоя-
тельно. Характеристики материала и нагрузки возьмите те же, что  
и в рассмотренном в пособии варианте. Выполните все виды расче-
тов и интерпретируйте результаты моделирования. Используя по-
лученную модель, рассчитайте варианты с измененными толщина-
ми раскосов и стоек. Выберите рациональный вариант по критерию 
материалоемкости. 

 

 
 

 
 

Рис. П3.1. Вариант 1 Рис. П3.2. Вариант 2 
  

 
 

 
 

Рис. П3.3. Вариант 3 Рис. П3.4. Вариант 4 
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Раздел 3 
 
 
 

ПОВЫШЕНИЕ ЭФФЕКТИВНОСТИ 

ГЕНЕТИЧЕСКИХ АЛГОРИТМОВ 
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ВВЕДЕНИЕ 
 
Генетические алгоритмы (ГА) – это алгоритмы, которые позво-

ляют найти удовлетворительное решение для аналитически нераз-
решимых или сложно решаемых проблем через последовательный 
подбор и комбинирование искомых параметров с использованием 
механизмов, напоминающих биологическую эволюцию. 

ГА применяются для решения следующих задач: 
– оптимизация функций; 
– разнообразные задачи на графах (задача коммивояжера, рас-

краска, нахождение паросочетаний); 
– настройка и обучение искусственной нейронной сети; 
– задачи компоновки; 
– составление расписаний; 
– игровые стратегии; 
– аппроксимация функций; 
– искусственная жизнь; 
– биоинформатика. 
ГА обладают следующими преимуществами: они не требуют ни-

какой дополнительной информации о поверхности функции выбора; 
разрывы, существующие в ней, незначительно влияют на эффектив-
ность оптимизации; устойчивы к попаданию в локальные оптимумы; 
хорошо работают при решении задач многоцелевой оптимизации;  
ГА просты в реализации, легко и удобно распараллеливаются. 

Однако ГА обладают и существенными недостатками, например, 
с помощью ГА проблематично найти точный глобальный оптимум; 
ГА неэффективно применять в случае оптимизации функции, тре-
бующей большого времени на вычисление; не для всех задач удает-
ся найти оптимальное кодирование параметров. 

С целью совершенствования ГА и преодоления указанных недо-
статков предлагается выполнить оптимизацию структур известных 
модификаций ГА. 

 
1. ГЕНЕТИЧЕСКИЕ АЛГОРИТМЫ 

 
Цели работы:  
– выполнить программную реализацию одной из модификаций 

классического генетического алгоритма, 
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– предусмотреть различные варианты реализации основных ге-
нетических операторов,  

– сравнить эффективность полученных структур генетических 
алгоритмов. 

 
2. КЛАССИЧЕСКИЙ ГА И ЕГО МОДИФИКАЦИИ 

 
В настоящее время существует целый класс ГА, направленный 

на решение разнообразных задач [13–19]. ГА оперируют совокуп-
ностью особей (популяций), которые представляют собой строки, 
кодирующие одно из решений задачи. Этим ГА отличается от боль-
шинства других алгоритмов оптимизации, которые оперируют лишь 
с одним решением, улучшая его. С помощью функции приспособ-
ленности среди всех особей популяции выделяют: 

– наиболее приспособленные (более подходящие решения), ко-
торые получают возможность скрещиваться и давать потомство; 

– наихудшие (плохие решения), которые удаляются из популя-
ции и не дают потомства. 

Таким образом, приспособленность нового поколения в среднем 
выше предыдущего. Функция приспособленности (fitness function) 
должна принимать неотрицательные значения на ограниченной об-
ласти определения (для того, чтобы мы могли для каждой особи 
считать ее приспособленность, которая не может быть отрицатель-
ной), при этом совершенно не требуются непрерывность и диф-
ференцируемость. Особи, входящие в популяцию, в ГА представ-
ляются хромосомами с закодированными в них множествами пара-
метров задачи, т. е. решений, которые иначе называются точками  
в пространстве поиска. 

Примерами различных ГА могут являться алгоритмы, рассмот-
ренные ниже. 

 

2.1. Классический ГА 
 

Классический ГА (называемый также стандартным, базовым, прос-
тым или элементарным) состоит из следующих шагов (рис. 2.1):  

1. Инициализация, или формирование исходной популяции. 
2. Вычисление функции приспособленности (вычисление при-

годности) хромосом в популяции. 
3. Вычисление условия окончания процесса. 
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4. Селекция хромосом с целью формирования пар родителей. 
5. Применение генетического оператора скрещивания (recombi-

nation) хромосом промежуточной популяции путем кроссинговера 
или кроссовера (crossover), что приводит к формированию нового 
поколения. 

6. Применение генетического оператора мутации (mutation). 
7. Формирование новой популяции. 
8. Формирование результата – выбор наилучшей хромосомы 
 

 
 

Рис. 2.1. Блок-схема классического генетического алгоритма 
 
В классическом ГА: 
– начальная популяция формируется случайным образом; 
– размер популяции (количество особей N) фиксируется и не из-

меняется в течение работы всего алгоритма; 
– используется двоичное представление хромосом, каждая особь 

генерируется как случайная L-битная строка, где L – длина коди-
ровки особи; 

– длина кодировки для всех особей одинакова; 
– селекция выполняется методом рулетки; 
– применяется одноточечное скрещивание. 
Для повышения эффективности работы классического ГА созда-

но множество его модификаций, в которых:  
1) разработаны различные варианты реализации каждого этапа;  
2) существенно изменена структура алгоритма.  

начальная популяция 

вычисление пригодности новая популяция

выбор 
родителей 

результат

мутация, pm

кроссинговер, рс

достигнут
критерий окончания 

процесса 

нет 

да
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Среди первой группы можно выделить различные методы селек-
ции родителей (пропорциональный, турнирный, локальный, ранжи-
рование и т. д.), сокращения популяции (элитарный, случайный, 
пропорциональный, селекционный и т. д.). Разработаны различные 
генетические операторы кроссинговера двоичных (одноточечный, 
многоточечный, однородный) и действительных значений (дискрет-
ная, промежуточная, линейная рекомбинация), мутации (однородная 
и неоднородная для двоичных и вещественных значений). 

Среди второй группы можно отметить ГА с динамически изме-
няемой мощностью популяции (различные стратегии выбора срока 
жизни особи), адаптивные ГА с подстраиваемыми параметрами (ве-
роятности кроссинговера и мутации), параллельные алгоритмы (мо-
дель островов, глобальная модель рабочий – хозяин, диффузионная 
модель), иерархические (многоуровневые) ГА. 

 
2.2. Варианты реализации основных этапов  

классического ГА 
 

2.2.1. Инициализация, или формирование  
исходной популяции 

 
В настоящее время наиболее известными и применяемыми на 

практике являются 3 способа создания исходной популяции (началь-
ного множества решений). 

Стратегия «одеяла» – формирование полной популяции, содер-
жащей все возможные решения. Например, для n-разрядной хромо-
сомы мы имеем всего 2n вариантов решений, которые составляют 
полную популяцию. 

Стратегия «дробовика» – генерация достаточно большого слу-
чайного подмножества решений. 

Стратегия «фокусировки» – генерация множества решений, вклю-
чающих разновидности одного решения.  

Первый подход (стратегия «одеяла») практически не реализуем 
даже для задач средней размерности, вследствие больших вычисли-
тельных затрат. Заметим, что при этом подходе начальная популя-
ция не может развиваться, т. к. в ней уже содержатся все возмож-
ные решения. Третий способ используется тогда, когда есть пред-
положение, что некоторое решение является вариацией известного 
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значения. В этом случае время поиска оптимального решения суще-
ственно сокращается, т. к. алгоритм начинает работу в окрестности 
оптимума. Чаще всего применяют второй способ. В этом случае  
в результате эволюции есть возможность перейти в другие подобла-
сти поиска и каждая из них имеет сравнительно небольшое прост-
ранство поиска. В целом эффективность ГА, качество решения и даль-
нейшая эволюция в значительной степени определяются структурой 
и качеством начальной популяции. На практике часто применяют 
комбинацию второго и третьего способов. Сначала определяются 
особи с высокими значениями целевой функции, а затем случайно 
формируются начальные решения в этих подобластях. 
 

2.2.2. Селекция хромосом (отбор) 
 
При отборе конкурентоспособных особей используют функцию 

приспособленности (fitness function), как единственно доступный 
источник информации о качестве решения. Но различные методы 
отбора родителей по-разному используют эту информацию. Слиш-
ком сильное предпочтение лучшим особям ведет к чрезмерному 
сужению области поиска решения и чревато преждевременной схо-
димостью в локальных экстремумах, и, наоборот, пренебрежение 
ими может привести к другой крайности – случайному поиску.  

В классическом ГА вероятность каждой особи попасть в про-
межуточную популяцию пропорциональна ее приспособленности, 
т. е. работает пропорциональный отбор (proportional selection).  
Существует несколько способов реализации данного способа се-
лекции хромосом: 

– stochastic sampling. Пусть особи располагаются на колесе ру-
летки так, что размер сектора каждой особи пропорционален ее 
приспособленности. N раз запуская рулетку, выбираем требуемое 
количество особей для записи в промежуточную популяцию. 

– Remainder stochastic sampling. Для каждой особи вычисляется 
отношение ее приспособленности к средней приспособленности 
популяции. Целая часть этого отношения указывает, сколько раз 
нужно записать особь в промежуточную популяцию, а дробная по-
казывает её вероятность попасть туда ещё раз. Реализовать такой 
способ отбора удобно следующим образом: расположим особи на 
рулетке так же, как было описано. Теперь пусть у рулетки не одна 
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стрелка, а N, причем они отсекают одинаковые сектора. Тогда один 
запуск рулетки выберет сразу все N особей, которые нужно запи-
сать в промежуточную популяцию. Такой способ иллюстрируется 
на рис. 2.2. 

 

 
 

Рис. 2.2. Иллюстрация метода remainder stochastic sampling 
 
Существуют также методы отбора, основанные не на вероятно-

стном подходе.  
Локальный отбор производится среди особей, которые нахо-

дятся в некоторой ограниченной среде, где определено отношение 
соседства на различных структурах: линейное, двумерное (4-, 6-, 8-
связное). При отборе родителей на первом шаге производится отбор 
особей случайным образом или одним из ранее рассмотренных спо-
собов. Далее для каждой отобранной особи определяется множе-
ство локальных соседей и среди них выбирается партнер для выпол-
нения операций скрещивания. Предыдущие методы отбора в какой-
то степени имеют аналогию с эволюцией естественных популяций. 
Отбор на основе усечения не имеет аналогов в естественной эво-
люции и обычно используются для больших популяций (N >100). 
При этом сначала отбираемые особи упорядочиваются согласно их 
значениям целевой функции. Затем в качестве родителей выбира-
ются только лучшие особи. Далее с равной вероятностью, среди них 
случайно выбирают пары, которые производят потомков. При этом 
методе используется параметр – порог отсечения (иногда использу-
ется термин интенсивность отбора), показывающий долю (часть по-
пуляции), которая отбирается в качестве родителей. Обычно исполь-
зуется порог от 10 % до 50 %. При турнирном отборе из популяции 
случайно отбираются m особей, затем лучшая из них выбирается  
в качестве родителя. Далее этот процесс повторяется, пока не сфор-
мируется промежуточная популяция, в которой случайно формиру-
ются пары родителей. Параметром этой процедуры является размер 
тура m, который принимает значения из диапазона от 2 до N. 

    1    2    3    4     5    6    7    8     9   10   11  12  13   14  15  16   17  18  19   20  21  22   23  24  25 
k 

   1      2    3        4    5   6   7    8     9       10   11 12   13    14  15   16   17  18   19   20 21 22  23     24     25 
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2.2.3. Операторы кроссинговера 
 
Различают операторы двоичной и вещественной рекомбинации 

(скрещивания). 
Двоичный кроссинговер. В классическом ГА применяется од-

ноточечный оператор кроссинговера (1-point crossover): для роди-
тельских строк случайным образом (чаще всего с вероятностью  
pc ≈ 0,5) выбирается точка раздела и производится обмен фрагмен-
тами хромосом после точки скрещивания, как показано в примере 
на рис. 2.3. 

 

А: 0 1 1 1 0 1 0 1 0

В: 1 0 0 1 1 0 1 0 1

  

А᾽: 0 1 1 1 0 0 1 0 1

В᾽: 1 0 0 1 1 1 0 1 0
 

Рис. 2.3. Одноточечный двоичный кроссинговер 
 

В случае многоточечного кроссинговера выбираются m позиций 
ki  1; 2; : : : ; N – 1 и их номера сортируются по порядку. Затем ро-
дители обмениваются фрагментами, заключенными между соседни-
ми выбранными позициями и производят, таким образом, двух по-
томков. То есть обмен здесь идет секциями. При этом секции между 
первой позицией и первой точкой скрещивания не обмениваются,  
а далее обмен идет через одну секцию, как это показано на рис. 2.4. 

 
А 0 1 1 1 0 0 1 1 0 1 0

            

В 1 0 1 0 1 1 0 0 1 0 1

           
А᾽: 0 1 1 0 1 1 1 1 0 1 1

В᾽: 1 0 1 1 0 0 0 0 1 0 0
 

Рис. 2.4. Многоточечный двоичный кроссинговер 
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Для этого случайным образом генерируется двоичная маска крос-
синговера той же длины (с тем числом бит), что и у хромосом роди-
телей. Четность бита маски показывает родителя, из которого копи-
руется ген потомка (например, 1 соответствует первому родителю,  
а 0 – второму). На рис. 2.5 показана схема выполнения этого типа 
кроссинговера на примере. 
 

Маска ОК 1 0 0 1 0 1 1 1 0 0 

1-й родитель 1 0 1 0 0 0 1 1 1 0 

           

Потомок 1 1 0 0 0 0 1 1 1 1 

          
2-й родитель 0 1 0 1 0 1 0 0 1 1 

 
Рис. 2.5. Однородный двоичный кроссинговер 

 
При ограниченном кроссинговере точки скрещивания могут вби-

раться только там, где значения генов у родителей различны. 
Кроссинговер действительных значений. Данная группа опе-

раторов разработана для хромосом, представленных действитель-
ными числами. 
Дискретный кроссинговер определен над векторами, компонен-

тами которых являются вещественные числа, и выполняется анало-
гично однородному кроссинговеру, определенному над двоичными 
векторами (рис. 2.6). 

 
1-й родитель 12 25 5 17 39 
2-й родитель 123 4 34 –5 11 

1-й образец (маска) 2 2 1 1 2 
1-й образец (маска) 1 2 1 2 1 

1-й потомок 123 4 5 17 11 

2-й потомок 12 4 5 –5 39 
 

Рис. 2.6. Дискретный кроссинговер вещественных векторов 
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Промежуточный кроссинговер применим только для особей, 
представленных только вещественными значениями. Здесь значе-
ния потомков строятся в окрестности или между значениями роди-
телей (рис. 2.7).  

 

1-й родитель 12 25 5 17 39 
2-й родитель 123 4 34 –5 11 
Случайно выбраны следующие значения коэффициента а
1-й образец (маска) 0,5 1,1 0,1 0,7 0,4 
1-й образец (маска) 0,1 0,8 0,5 1,1 0,3 
1-й потомок 67,5 1,9 2,1 1,6 27,8 
2-й потомок 23,1 8,2 19,5 –7,2 30,6 

 
Рис. 2.7. Промежуточный кроссинговер  

 
Потомок формируется следующим образом: 
 

A′ = A + λ (B – A), 
 

где A, B – вещественные значения – родители; 
 A′ – вещественное значение – потомок; 
 λ	  [−d; d + 1] – случайный масштабирующий множитель.  

В случае обычного промежуточного кроссинговера d = 0 и λ  [0; 1]. 
Для обобщенного промежуточного кроссинговера d > 0. Значение 
каждого потомка формируется по приведенному выражению, но со 
своим λ. В случае особи-вектора случайным образом формируется 
вектор масштабирующий множители λ = (λ1; λ1; : : : ; λn) и потомок-
вектор определяется покомпонентно. Фактически, этот оператор 
заимствован из другого направления эволюционных вычислений – 
«эволюционные стратегии». 
Линейный кроссинговер аналогичен предыдущему, за исключе-

нием того, что значение масштабирующего множителя а одинаково 
для всех компонент векторов. 

 
2.2.4. Операторы мутации 

 
К полученному в результате отбора и скрещивания новому по-

колению (потомкам) применяется оператор мутации, необходимый 
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для «выбивания» популяции из локального экстремума и способ-
ствующий защите от преждевременной сходимости. Мутация мо-
жет быть выполнена различными способами. 

Двоичная мутация. В классической мутации каждый бит каж-
дой особи популяции с некоторой вероятностью pm инвертируется. 
Эта вероятность обычно очень мала, менее 1 %. 

Иногда используется оператор инверсии, фактически являющий-
ся разновидностью классической мутации. При этом случайным 
образом выбираются две позиции в особи, и далее производится 
обмен значениями генов между ними. Пример выполнения этого 
оператора представлен на рис. 2.8. 

 

 
 

Рис. 2.8. Мутация-инверсия 
 
Можно выбирать некоторое количество точек в хромосоме для 

инверсии, причем их число также может быть случайным. Среди 
рекомендаций по выбору вероятности мутации нередко можно встре-
тить варианты 1/L или 1/N. 

Мутация над вещественными числами. Мутация над веще-
ственными потомками выполняется путем сложения особи с не-
большим случайным значением, которое называется шагом мута-
ции. Выбор размера шага мутации зависит от рассматриваемой 
проблемы, и шаг в общем случае может изменяться в процессе ре-
шения задачи. Маленький шаг дает большую точность, но ведет  
к большим временным затратам. 

 
2.2.5. Стратегии формирования нового поколения 

 
Можно выделить два основных типа формирования нового по-

коления после кроссовера и мутации:  
– дети замещают родителей; 
– новое поколение составляется из совокупности детей и их  

родителей. 
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Также применяется принцип элитизма: в новое поколение вклю-
чается заданное количество лучших особей предыдущего поколе-
ния (часто одна лучшая особь).  

Использование второй стратегии и элитизма не допускает потери 
лучших решений. К примеру, если популяция сошлась в локальном 
максимуме, а мутация вывела одну из строк в область глобального, 
то при замещении родителей весьма вероятно, что эта особь в ре-
зультате скрещивания будет потеряна, и решение задачи не будет 
получено. Если же используется элитизм, то полученное хорошее 
решение будет оставаться в популяции до тех пор, пока не будет 
найдено лучшее. 

 
2.2. ГА с изменяемой мощностью популяции 

 
В этой модификации ГА отсутствуют этап и механизм селекции 

родителей. Вместо этого вводится концепция возраста особи. Каж-
дой особи после ее рождения на текущем этапе оценки функции 
приспособленности присваивается life time (срок жизни) – параметр, 
зависящий от функции приспособленности особи. Таким образом, 
каждая особь живет определенное число поколений и умирает по 
окончанию заданного срока жизни. Очевидно, значение параметра 
life time влияет на размер популяции. Чем больше срок жизни, тем  
в большем числе поколений популяций живет данная особь, что 
увеличивает средний размер популяции.  

Структура такого ГА выглядит следующим образом: 
1. Инициализация или формирование исходной популяции. 
2. Вычисление функции приспособленности (вычисление при-

годности) хромосом в популяции. 
3. Определение срока жизни хромосом. 
4. Вычисление условия окончания процесса. 
5. Увеличение возраста каждой хромосомы на 1. 
6. Селекция хромосом с целью формирования пар родителей. 
7. Применение генетического оператора скрещивания (recombi-

nation) хромосом промежуточной популяции путем кроссинговера 
или кроссовера (crossover), что приводит к формированию нового 
поколения. 

8. Применение генетического оператора мутации (mutation). 
9. Определение срока жизни хромосом. 
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10. Удаление из популяции всех хромосом с возрастом больше 
срока жизни. 

11. Формирование результата – выбор наилучшей хромосомы. 
 

2.3. Последовательные модификации классического ГА 
 

2.3.1. Алгоритм Genitor 
 

В данной модели используется специфичная стратегия отбора. 
На каждом шаге только одна пара случайных родителей создает 
только одного ребенка. Этот ребенок заменяет не родителя, а одну 
из худших особей популяции.  

Таким образом, на каждом шаге в популяции обновляется толь-
ко одна особь. 

 

2.3.2. Алгоритм SteadyState (SSGA) 
 

Алгоритм SSGA напоминает предыдущий. SSGA не формирует 
промежуточную популяцию как классический ГА, а осуществляет 
последовательно выбор пары наилучших индивидов. Затем к этой 
паре применяются генетические операторы скрещивания и мутации 
с целью формирования наследников, которые заменяют худших ин-
дивидов популяции. 

 

2.3.3. ГА селекционеров 
 

ГА селекционеров использует знания, полученные селекционе-
рами в области искусственной селекции. В этом алгоритме «вирту-
альный селекционер» отбирает некоторый процент хромосом из 
первоначальной популяции для создания потомков. Именно этим 
алгоритм отличается от классического ГА. Все остальные этапы 
остаются неизменными. 

 

2.3.4 Алгоритм CHC 
 

CHC – это Cross generational elitist selection, Heterogenous recom-
bination, Cataclysmic mutation. 

В этом алгоритме для нового поколения выбираются N лучших 
различных особей среди родителей и детей. Дублирование строк не 
допускается. Для скрещивания все особи разбиваются на пары, но 
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скрещиваются только те пары, между которыми расстояние Хэм-
минга больше некоторого порогового (также возможны ограниче-
ния на минимальное расстояние между крайними различающимися 
битами). При скрещивании используется так называемый HUX-опе-
ратор (Half Uniform Crossover), разновидность однородного кроссо-
вера – каждому потомку переходит ровно половина битов каждого 
родителя. Размер популяции небольшой. Этим оправдано использо-
вание однородного кроссовера.  

В CHC применяется cataclysmic mutation: все строки, кроме са-
мой приспособленной, подвергаются сильной мутации (изменяется 
около трети битов). Таким образом, алгоритм перезапускается и 
далее продолжает работу, применяя только кроссовер. 

 

2.3.5. Гибридный ГА 
 

Использование гибридного алгоритма позволяет объединить 
преимущества ГА с преимуществами классических методов. 

Дело в том, что ГА являются робастными алгоритмами, т. е. поз-
воляют находить хорошее решение, но нахождение оптимального 
решения зачастую оказывается намного более трудной задачей  
в силу стохастичности принципов работы алгоритма. Поэтому воз-
никла идея использовать ГА на начальном этапе для эффективного 
сужения пространства, поиска вокруг глобального экстремума, а за-
тем, взяв лучшую особь, применить один из «классических» мето-
дов оптимизации. 

Однако можно использовать «классические» методы (hill-climbing, 
например) и внутри самих ГА. На каждом поколении каждый полу-
ченный потомок оптимизируется этим методом, таким образом, 
каждая особь достигает локального максимума, вблизи которого 
она находится, после чего подвергается отбору, скрещиванию и му-
тации. Такой метод ухудшает способность алгоритма искать реше-
ние с помощью отбора гиперплоскостей, но зато возрастает вероят-
ность того, что одна из особей попадет в область глобального мак-
симума и после оптимизации окажется решением задачи. 
 

2.4. Параллельные модификации классического ГА 
 

ГА применяются и при параллельных вычислениях. При этом 
формируется несколько живущих отдельно популяций. На этапе 
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формирования нового поколения по некоторому правилу отбирают-
ся особи из разных популяций. Сгенерированная таким образом по-
пуляция в некоторых случаях заменяет все остальные. В результате, 
так или иначе, происходит миграция особей из одной популяции в 
другие. Поэтому параллельные ГА иногда называют миграциями. 

 
2.4.1. Параллельный ГА на базе популяций 

 
В этом алгоритме используются N/2 процессов при популяции  

в N индивидов (здесь и далее процесс рассматривается как некото-
рая машина, процессор, который может работать независимо). Каж-
дый из них дважды случайным образом выбирает из общей памяти 
две особи и оставляет лучшую. Две выбранные особи затем подвер-
гаются скрещиванию, мутации и оценке степени пригодности. По-
лученные потомки размещаются в общей памяти. 

 
2.4.2. Миграция 

 
Миграционная модель (модель островов) разбивает популяцию 

решений на множество подпопуляций (одна большая разбивается на 
множество мелких). Эти подпопуляции функционируют независимо 
друг от друга некоторое число поколений (срок изоляции). По до-
стижению срока изоляции производится обмен между подпопуля-
циями. При этом задаются: 

– число обмениваемых особей – степень миграции; 
– метод отбора особей для миграции; 
– схема миграции, которая определяет способ обмена между 

подпопуляциями. 
Выбор особей для миграции может осуществляться несколькими 

методами, как и отбор родителей. Существует также несколько стан-
дартных схем обмена отобранными особями между подпопуляциями: 

– каждая подпопуляция обменивается с каждой из остальных 
подпопуляций; 

– обмен по кольцу; 
– обмен между соседними подпопуляциями. 
Параллельная реализация миграционной модели показала не толь-

ко увеличение скорости вычислений, но и меньшее число событий – 
вычислений значений функции приспособленности для особей по 
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сравнению с классическим ГА (одна популяция). Поэтому даже для 
однопроцессорного компьютера последовательная реализация па-
раллельного алгоритма (псевдопараллельная реализация) обычно 
дает лучшие результаты. 

 

2.4.3. Модель «Рабочий – Хозяин» 
 

В глобальной модели «Рабочий – Хозяин» на нижнем уровне каж-
дый «рабочий» имеет свою популяцию, каждая из которых развива-
ется самостоятельно. На верхнем уровне «Хозяин» получает с ниж-
него уровня значения функции приспособленности из всех подпо-
пуляций и управляет ими путем коррекции основных параметров 
ГА нижнего уровня таких как мощность популяции, вероятности 
скрещивания и мутации и т. п. 

 

2.4.4. Диффузионная модель 
 

Диффузионная модель работает с каждой особью индивидуально 
и выбирает партнера для скрещивания подобно локальному отбору 
родителей. Таким образом, имеет место «диффузия» информации  
в популяции.  

 
3. ОСНОВНЫЕ ЭТАПЫ И ТРЕБОВАНИЯ  

К ВЫПОЛНЯЕМОЙ РАБОТЕ 
 

Цель работы: В ходе выполнения лабораторной работы необхо-
димо разработать программный модуль, позволяющий сформиро-
вать оптимальную структуру заданного ГА. Рассмотрим подробнее 
требования к функциональности программного модуля. 
Тема: Реализация распределенного параллельного генетического 

алгоритма (РПГА). 
Начальные условия: Наброс начальных точек – треугольная сетка 

(несколько заданных заранее вариантов); селекция – турнир; скре-
щивание – двухточечное; мутация – задается вероятностью [0; 1]; 
параметры Х1, Х2 изменяются в интервале [1; 5] с точностью 0,1. 
Функция Y = ln(X1) + X2 минимизируется. 
Описание алгоритма: Используются независимые конкурирую-

щие подпопуляции, которые обмениваются особями с заданной час-
тотой. Шаги: 
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0. Инициализация. Определение генетического представления 
задачи. 

1. Создание первоначальной популяции и разделение ее на под-
популяции. 

2. Для каждой подпопуляции выполняются параллельно следую-
щие шаги: 

2.1. Применение в течение заданных поколений селекции, скре-
щивания и мутации. 

2.2. Перемещение нескольких хромосом в соседние подпопуляции. 
2.3. Получение такого же количества хромосом из соседних под-

популяций. 
3. Возврат к шагу 2. 
Реализация: Программа представляет собой приложение  

WindowsForms, написанное на языке С#. Интерфейс представлен  
на рис. 3.1. 

 

 
 

Рис. 3.1. Главное окно программы 
 

Параметры, задаваемые пользователем: 
– Количество начальных точек (6, 8, 24). 
– Количество подпопуляций (P). 
– Выживает особей, т. е. переходит на следующее поколение (n). 
– Поколений до остановки (К). 
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– Поколений перед смешиванием (r). 
– Вероятность мутации (М). 
После задания параметров нажимаем кнопку «Инициализация». 

Происходит генерация начальной популяции (поколение под номе-
ром 0), разбиение особей на подпопуляции (каждая подпопуляция 
имеет номер, начиная с 1). Каждая точка в подпопуляции имеет 
свой номер, начиная с 1. Идентификатор точки составляется из но-
мера подпопуляции и номера точки (например, «1.2»). 

Можно произвести автоматический расчет, нажав кнопку «Авто-
расчет» (рис. 3.2). Шаги генетического алгоритма выполняются для 
заданного количества поколений, и лучшая особь выводится от-
дельной строкой в конце таблицы, а также отмечается жирной зеле-
ной точкой на графике. 

 

 
 

Рис. 3.2. Результат авторасчета 
 

Переходить на каждое следующее поколение можно нажатием 
кнопки «Следующее поколение» (рис. 3.3). В этом случае новое поко-
ление добавляется в конец таблицы, а особи подпопуляций отмеча-
ются на графике точками (каждая подпопуляция имеет свой цвет). 

Таблица содержит информацию о каждой особи: значение при-
способленности (функции) F; значения параметров X1 и X2; значе-
ние хромосомы (параметров X1 и X2, переведенные в двоичный код). 
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При нажатии кнопки «Следующее поколение» происходят:  
1. Селекция. В каждой подпопуляции особи разбиваются на пары 

случайным образом и из каждой пары выбирается лучшая (по зна-
чению приспособленности). Она выживает. Из каждой подпопуля-
ции выбирается указанное пользователем количество особей. 

 

 
 

Рис. 3.3. Первое поколение из трех  
 

2. Скрещивание. В каждой подпопуляции особи разбиваются на 
пары случайным образом. Каждая пара дает два потомка в соответ-
ствии с правилами двухточечного скрещивания (точки выбираются 
случайным образом). Если в подпопуляции нечетное количество 
особей, то оставшаяся без пары особь дает одного потомка инвер-
сией (две точки для инверсии выбираются случайным образом). 

3. Мутация. Для каждой особи генерируется случайное число из 
интервала [0; 1]. Если оно меньше указанной пользователем веро-
ятности мутации, то особь мутирует. Новая особь при этом не рож-
дается. Мутировавшая особь отмечается в таблице более темным 
цветом (рис. 3.4). 

 

 
 

Рис. 3.4. Особь 1.2 мутировала 
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Мутации подвергаются как выжившие особи (с прошлого поко-
ления), так и их потомки, образованные на шаге 2. 

4. По прошествии указанного пользователем количества поколе-
ний происходит смешивание подпопуляций. Подпопуляции случай-
ным образом разбиваются на пары. Внутри каждой пары первая 
подпопуляция «отдает» второй одну особь, а вторая отдает одну 
особь первой. При нечетном количестве подпопуляций одна подпо-
пуляция остается без пары, ее особи никуда не переходят (рис. 3.5). 

 

 
 

Рис. 3.5. Смешивание подпопуляций 
 

На рис. 3.5 видно, что особь 1.1 в результате смешивания пе-
решла в 2, а особь 2.3 перешла в 1. 

После выполнения заданного количества шагов (поколений) 
находится лучшая особь и выводится отдельной строкой в конце 
таблицы, а также отмечается жирной зелёной точкой на графике. 
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